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Thank you for purchasing Network Video Recorder VK-64 v1.4 (hereafter referred to as
“VK-64”), a network video recording and monitoring system. VK-64 is a network video
recording and monitoring system and consists of the Storage Server and Viewer. Please
read this manual prior to operation to ensure you will be able to use the Viewer and
Storage Server effectively. This manual also explains how to use the Network Video
Recorder VK-16 v1.4 and Viewer-Only use. See P.7 for the difference between the VK-64
and VK-16. See P.42 for the functions not available in the Viewer Only mode.
* VK-16 has the same functionality as VK-64 outlined in this manual, unless explicitly indicated

otherwise.

Request to Customers
(1) Canon owns the copyright of this manual. The content of this manual may not be reproduced in

its entirety or in part without prior permission.
(2) The content of this manual is subject to change without notice.
(3) All possible measures have been taken to ensure that the content of this manual is accurate. If

you happen to notice errors, omissions or other faults, please contact your vendor.
(4) Irrespective of items (2) and (3) above, Canon cannot bear responsibility for any effects that

result from operation.
(5) When description of this manual uses the Control Panel, it conforms to operations with Window

XP Classic style.

Request to Customers (Indemnity)
Software defect may cause an error in recording and damage or loss of recorded data. Canon
cannot bear responsibility for any effects that result from operation. You should agree with it before
using the product.

Support Information
For various types of information relating to support, including updated product software (patch installer),
User’s Manual, operating environment, etc., please refer to Canon Web site.

Copyright Information
Please note that copyright laws prohibit the customer from using recorded videos and still pictures for
any purpose other than personal requirements, without permission from the copyright holder.

Trademarks
● Canon and the Canon logo are registered trademarks of Canon Inc. 
● Microsoft Windows is a trademark of Microsoft Corporation in the United States and other countries. 
● Windows is legally recognized as Microsoft Windows Operating System. 
● QuickTime is a trademark of Apple Computer Inc.  
● Apache is a trademark of the Apache Software Foundation. 
● Pentium is a trademark of Intel Corporation. 
● All other company or product names used in this manual are trademarks or registered trademarks of

their respective holders.

Icons Used in this Manual
Indicates important information that must be observed or actions that are
prohibited during an operation. These notes must be read to prevent possible
faults or errors during operation.
Indicates supplementary information or a reference to an operation. Users
are advised to read these memos.

Tip

Note

Introduction

Storage Server includes software developed by the Apache Software Foundation (www.apache.org). Apache software is
protected by the copyright law (Copyright(c) 2000-2003 Apache Software Foundation). For the license terms associated with
this software, please refer to the file APACHE_LICENSE in the folder LICENSE, within the installation directory.
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Overview

● VK-64/VK-16 is a software to view and record video images distributed from the
VB150 or a network camera VB-C300/VB-C50i/VB-C50iR/VB-C50FSi/VB-
C50Fi/VB-C10/VB-C10R (hereafter referred to as “camera server”). VK-64/VK-16
supports up to 64 camera servers via an IP network (e.g., LAN). Although VK-16
has the same basic functionalities as VK-64, it can support up to 16 camera
servers.

● VK-64/VK-16 is a software program which consists of the Storage Server and Viewer.
The Storage Server can record videos and events (sensor input and motion detection)
data from multiple camera servers. The Viewer can display videos from multiple
camera servers in real time and play back videos recorded on the Storage Server.

● The Viewer can be used by itself without connecting to the Storage Server (Some
functions such as video recording, sensor events, and motion detection, Capture
Still Frame are not available) (➝ P. 18, P. 42).

● Video resolution can be as high as 640 x 480 pixels, 30 fps for NTSC and 25 fps
for PAL (depending on Camera Servers installed).

● The following table shows each product and license number:

Product Name Storage Server Viewer

Network Video Recorder VK-64 v1.4 1 license 1 license

Network Video Recorder VK-16 v1.4 * 1 license 1 license

Network Video Recorder VK-64 v1.4 Viewer 1 license

Network Video Recorder VK-64 v1.4  5 Viewers 5 licenses

* The Storage Server for VK-16 can register up to 16 camera servers. VK-16 and VK-64 uses the same Viewers.
* Licenses to the VK-64/VK-16 v1.1, v1.2 and v1.3 can be used for v1.4.

Storage ServerViewer
VK-64 Up to 64 cameras can be registered

Up to 16 cameras can be registered Common
VK-16 Functionality is the same as for VK-64

except for the above camera limitation.
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System Configuration

Typical System Configuration
VK-64 /VK-16 provides video viewing and recording from Camera Servers via an IP
network such as a LAN. Since VK-64/VK-16 makes use of IP networks, installations of
cameras can be performed easily. In addition, it is possible to flexibly install new cameras
and change installation locations of cameras.

VC-C50i VC-C50iR VB150

VB-C300

VB-C50iR

Pla
yb

ac
k

Pla
yb

ac
k

Playback

Monitor

View live and recorded video
Viewer

Operator Capabilities:

● Viewing Live Video  ● Viewing Events  ● Viewing recorded Video

VB-C50FSi/VB-C50Fi

VB-C50i
Li

ve

Li
ve

Live

Live

Monitor
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System Configuration

■ Application Types and Functions

Application Function

Storage Server Stores recorded information.

Viewer
Lets users view recorded information, monitor live video and
acknowledge/search events. Lets Administrators configure
recording and viewing settings.

Playback

Record

Record Monitor

Record video to the Storage Server #1
Storage Server

Administrator Capabilities:

● Configure Storage Server  ● Configure Event Notification  ● Configure Users

View live and recorded video
Viewer

Administrator Capabilities:

● Configure recording settings  ● Configure event alerts

● View Live Video  ● View Events  ● View recorded Video

● Configure Camera Servers  ● Configure Storage Server

Record video to the
Storage Server #2
Storage Server

Receives and 
records video.

Plays back recorded
video to Viewers.

Playback
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Set up the Camera Servers

Overview of Setup

1

This section explains how to install and configure the Storage Server and Viewer.

The first step is to set up your cameras and/or Camera
Servers. Refer to your camera and Camera Server
manuals for connection details.

Camera Servers (→ P. 12) 

Install the Storage Server and Viewer2
The Storage Server and Viewer can be installed on one
computer. Alternatively, the Viewer can be installed on other
computers on the network that will access recorded video from
the Storage Server.

Configure the Storage Server via the Storage
Server Configuration utility to set server settings,
event notification and configure user privileges.

VC-C50i

VB150
VB-C50FSi

VB-C50i
VB-C300



Overview of Setup
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Monitor live video and play
back recorded events in
the Viewer application.
From the Viewer you can
customize the Viewing
Area and save Layouts.

Configure Recording Settings3

Create and save Viewer Layouts4

Register Camera Servers and Storage Servers
and set up recording schedules.

Recorded video from
Storage Server

Live video from
Camera Servers



The table below lists the Camera Servers that are supported by VK-64/VK-16.

This information is correct as of November 2007. For the latest information, please
refer to Canon Web site.

Firmware Upgrade
The latest information concerning firmware can be found on Canon Web site.

12

Supported Camera Servers

Camera Server Firmware Version

VB-C300 Ver. 1.0

VB-C50FSi Ver. 1.0 Rev. 77 or later

VB-C50Fi Ver. 1.0 Rev. 77 or later

Ver. 1.0 Rev. 26 or later

VB150 Ver. 1.1 Rev. 41 or later

VB-C50iRVB-C50i

● If using a VB150 with multiple cameras, there are restrictions
on frame rate.
Refer to your VB150 User’s Manual for details (→ P. 36). 

● If using the Simultaneous mode with the VB150, upgrade the
firmware to Version 1.1 Rev.41 or later.

Note

VB-C10RVB-C10

Ver. 1.1 Rev. 33 or later
or

Ver. 1.2 Rev. 77 or later
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This information is correct as of November 2007. For the latest information, please
refer to Canon Web site.

Viewer

Operating Environment

Storage Server

Minimum

CPU Pentium 4  2.2GHz or greater

Operating System Windows 2000 Server (SP4)
Windows 2000 Professional (SP4)
Windows XP Professional (SP2)
Windows Server 2003 Standard Edition (SP2)
Windows Server 2003 R2 Standard Edition (SP2)
Windows Vista Business/Enterprise/Ultimate

Memory 1GB RAM or greater
For more than 48 Camera Servers, 1.5GB or greater required.

Hard Disk 20GB HDD or greater, SCSI or IDE, NTFS formatted

* The requirements for Storage Server will vary according to the environment you will use (number of
Camera Servers, setting of recording frame rate etc.). It is also dependent on pre-event recording
settings. Please contact dealers that handle Canon products for further information. If using
Windows XP Professional SP2 or Windows Server 2003, follow the procedures as described in
“Administrator’s Manual” for changing your Windows settings.

* Only 32-bit Edition of Windows XP, Windows Server 2003 and Windows Vista are supported.

* If using Windows XP Professional SP2 or Windows Server 2003, follow the procedures as
described in “Administrator’s Manual” for changing your Windows settings.

* Only 32-bit Edition of Windows XP, Windows Server 2003 and Windows Vista are supported.

Minimum

CPU Pentium 4  2.2GHz or greater

Operating System Windows 2000 Server (SP4)
Windows 2000 Professional (SP4)
Windows XP Professional (SP2)
Windows Server 2003 Standard Edition (SP2)
Windows Server 2003 R2 Standard Edition (SP2)
Windows Vista Business/Enterprise/Ultimate

Memory 1GB RAM or greater

Hard Disk 2GB RAM or greater

Display 1024 x 768 or higher resolution for the effective display area
Color display of 16 bits or more 
A high performance video card is desirable. With PCI video cards,
display performance may be reduced.

Sound Audio playback support is necessary for event notification alert sounds
(→ P. 120).
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● Recording and display of live videos may not be provided as
configured because many factors (such as network environment
and PC performance) affect the actual performance of VK-
64/VK-16.

● When the load on your computer CPU and hard disk is high,
the specified frame rate may not be available, or the video
recording may be interrupted or the Viewer operation may take
longer. Also, when available disk space is low, the disk load
may increase and the video recording may be interrupted due
to deletion of the recorded video file.

● Using anti-virus and firewall software may affect Storage
Server and Viewer operations.

● When using a proxy server (→ P. 26, P. 40)
If you use a proxy server, recording frame rate may not be
achieved as specified or live video monitoring may be
interrupted. Also, communication between the Storage Server
and Viewer may occasionally be disconnected.

● If you are using Windows XP SP2 or Windows Server 2003,
you need to change Windows settings. Make sure to change
the settings. Refer to “Administrator’s Manual”.

● When recording to a NAS server, it is recommended to
separate the communication networks for the camera and
NAS. Refer to “Administrator’s Manual” for the details.

● A NAS server cannot be used if you are using Windows 2000.
● Use recommended NAS servers with Windows Storage Server

2003 or Windows Storage Server 2003 R2.
● Audio function of the VB-C300/VB-C50i/VB-C50iR/VB-C50FSi

can also be used.
• The VK Viewer supports audio transmission and reception.
• Audio recording is not available.
• The audio and video may be out of sync.
• Depending on the performance of your PC and network

environment, the audio stream may be interrupted.
• The audio feature is not available via a proxy server.
• If you use a PC on which anti-virus software is installed, the

audio stream may be delayed or the audio stream may be
temporarily interrupted.

Note

Before Starting Operations with VK-64/VK-16 <Important>

It is recommended that you perform tests under actual conditions before starting
operations.



Chapter 1
Installation

This chapter outlines the installation of the Storage Server and Viewer.
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Before you begin installation...

System Configuration

● When Viewing and Recording with one PC

Load on PC may increase depending on the number of Camera Servers and recording
schedule.

● When Viewing and Recording with one Storage Server and
Multiple Viewers

VB-C300

Record video to the Storage Server
Storage Server

View live and recorded video
Viewer

● Having many Viewers accessing the same Camera Servers
and Storage Servers will affect system performance.

● Installation of both Storage Server and Viewer on a single PC
may cause a heavy load on your PC depending on the number
of Camera Servers or recording schedule. If you use VK-64
/VK-16 with many Camera Servers, install each application on
separate PCs.
Viewing with a low capacity PC may take longer, the specified
frame rate may not be achieved, recording frame rate may be
lower or recording may be interrupted.

Note

Viewer

Storage
Server

Viewer

Record video to the Storage

Server

Storage Server

View live and recorded video

Viewer

View live and recorded video

Viewer

Receive and record

video

Receive video and

control camera
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1

Installation

● When using multiple Storage Servers and Viewers

One or more Storage Servers can be used on a network and Viewer applications can be
configured to play video from more than one Storage Server. For each Viewer, a Master
Storage Server (→ P. 18) needs to be defined for saving information such as zones and
locations of cameras, as well as saving Viewer layouts created by the user.

Before you begin installation...

● You can operate VK-64/VK-16 with up to ten Storage Servers
using any combination of VK-64 Storage Server and VK-16
Storage Server. Up to 192 Camera Servers can be operated.

● Up to ten Viewers can connect to the Storage Servers at the
same time.

● If the Storage Server and/or Viewer are installed on multiple
PCs, you’ll need to purchase the necessary licenses
separately (➝ P. 7).

Note

Viewer

Storage
Server

Storage
Server

Viewer

Storage
Server

Record video

to the Storage Server #1
Storage Server

Receive and record video

Receive video and control

camera

Play back recorded

video

View live and recorded events

Viewer

Record video to

the Storage Server #3

Storage Server

View playback video from Storage Server #1

Play back recorded

video

Receive and

record video

Record video to

the Storage Server #2

Storage Server

More than one Storage Server can be
added to a network. Viewers can receive
playback video from more than one
Storage Server.

View playback video from

Storage Server #2 and #3

Viewer

Setting up the Camera Servers

First make sure the firmware is the required version or later (as specified in the table
➝ P. 12).

1



18

Before you begin installation...

Check to ensure the Camera Server has been correctly installed and that the initial
settings (network settings) have been made. Then connect to the network.

For procedures on installing and setting up Camera Servers and cameras, please
see the User’s Manual supplied with the Camera Servers and cameras.

2

When using multiple Storage Servers
If multiple Storage Servers are being used, you should decide which one is the Master
Storage Server. A typical multiple Storage Server arrangement could be:

Viewer

Master Storage Server

Storage Server #2

Storage Server #3

Play Video to Viewer

Play Video to Viewer

Play Video to Viewer

Load Camera Server information

Load Zones and Locations

Load Viewer Layouts

Save Camera Server information

Save Zones and Locations

Save Viewer Layouts

When using Viewer alone
The Viewer can be used by itself without connecting to the Storage Server. Although there
are some restrictions on functions such as recording and Event Search (➝ P. 42), Viewer-
Only mode allows to view live videos.

When multiple Storage Servers are operated, if the Storage
Servers other than the Master Storage Server are stopped, it
takes time to display the Configuration and Preferences screen
(approximately up to 30 seconds).

Note

● It is recommended that all Viewers within a system use the same
Storage Server as a Master Storage Server. This ensures that all
Viewers use the same Zones, Locations and Viewer Layouts.

● For correct operation, the time setting of all PCs within a
system (including Storage Servers and Viewers) must be
correct. We recommend that you use NTP function to set the
time for Storage Server automatically.

● Adjusting the time of Storage Server during recording may
cause problems to the recording video.

Note

About the Master Storage Server
A Master Storage Server is the Storage Server which a Viewer will connect to in the first
place. Information about Camera Servers, Locations and Zones and Viewer Layouts are
stored on the Master Storage Server. The Viewer extracts the information from the Master
Storage Server.
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Starting up the Installer

Insert the Network Video Recorder instal-
lation disc into your CD drive. The Welcome
screen appears. Click Next to continue.

If the installer does not automatically load,
open the CD directory in Explorer and
browse to locate Setup.exe. Double-click
to begin installation. 

1

The Software License Agreement screen
appears. Read the agreement carefully.
Click the radio button, I accept the terms
in the license agreement and then click
Next to continue. 

2

Enter your License Key(s) and click Next.
Your License Key is indicated on the
“About License Key” included in the
package.

3

Installation Procedures

Types and number of licenses you can install vary according to
the product you have purchased. If additional Storage Server
and Viewer installations are required, you wil l  need to
purchase the necessary software for each PC (➝ P.7). 

Note 1

Installation

If you are installing the Storage Server alone, enter the License
Key for the Storage Server only. If you are installing the Viewer
alone, enter the License Key for the Viewer only.Tip
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Installation Procedures

Click Next to continue. See “Tip” below for the Help and Space buttons.

When you click Next, installation will proceed and a progress bar will be displayed.

When the InstallShield Wizard Completed
screen displays, click Finish.

Installation is now finished.

5

● In future, if you need to check your product type, refer to the
About box of the Storage Server or Viewer (→ P. 25).

● If the Storage Server is installed, it will be automatically
started after installation.

Note

● Click Help to obtain details on the type of installation. The type
is indicated by the icon next to the application to be installed.
You can set a custom install here.

● Click Space to view the amount of disk space required in order
to install VK-64/VK-16. A list of drives is shown. 

In either dialog, click OK to return to the installation steps.

Tip

Depending on your License Key, you will
be presented with one or both of the
following applications shown below:

● Viewer

● Storage Server

It is recommended to keep the Install to: path
as is. Click Change... to choose another
installation path if necessary.

4
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1

Installation

Upgrading from Version 1.0, 1.1, 1.2 and 1.3
When installing over an earlier version, VK-64/VK-16 will attempt to use settings from
your previous installation. It is important to verify your settings after installation.

● If you are using VK-64/VK-16 with NAS server, you need to set
up log-on settings again after upgrading VK from v1.3 to v1.4.

● The Viewer v1.4 can connect to the Storage Server v1.2 and
v1.3. However, if you connect to the Storage Server v1.2, you
cannot use the recording functions which are not supported by
v1.2 (e.g., preset tour).

● If the Storage Servers v1.2, v1.3 or v1.4 coexist, either Storage
Server can be specified as the Master Storage Server.

● The Viewer v1.4 cannot connect to the Storage Server v1.0 or
v1.1.

● The Viewer v1.0, v1.1, v1.2, or v1.3 cannot connect to the Storage
Server v1.4.

● When upgrading from any versions before 1.1.2.27, you need
to set motion detection (➝ P. 85) again. You can check your
version information from the About box (➝ P. 25) of the
Storage Server and the Viewer.

● The VB-C300 cannot be registered on the Storage Server v1.0,
v1.1 or v1.2.

Note
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Chapter 2
Configuring the Storage Server

This chapter shows Administrators how to start and stop the Storage Server as required.
It also explains how to configure the Camera Server proxy for the Storage Server,

set disk space used, set event notifications and configure users.

If you are using the Viewer only, 

you can skip this chapter.



Double-click the Storage Server Configuration desktop icon.

Alternatively, from the Windows Start menu select: Programs >
WebView Livescope > Network Video Recorder VK Series v1.4 >
Storage Server Configuration.

If User Account Control is enabled on Windows Vista, the User
Account Control screen will be displayed.

In this case, click the Allow button.

To configure the Storage Server, you must log into Windows with the
Windows Administrator privilege.

24

Configuring the Storage Server
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Configuring the Storage Server
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Configuring the Storage Server
The Storage Server Configuration dialog, Settings tab allows you to configure:

● Storage Server name    ● Proxy Servers    ● Recording options

● Change the Storage Server Name

Enter a new name in Storage Server
Name to change the Storage Server
name (You can use up to 20 characters).

Enter a name for your Storage Server.

Click the icon of the toolbar or right-click the
title bar to display the About box.

Set maximum disk space used for each
device. Also, add or remove network
drives.

Enter a proxy address for connecting to
Camera Servers.

Storage Server status indicator. The Start
Storage Server and Stop Storage Server
buttons start and stop the Storage Server.

Click Apply to save changes when you
modify settings from each tab.

It is recommended to use an easy-to-understand name if you are
using multiple Storage Servers.

Tip

Set Maximum retained history, Maximum
file size / duration and Low disk space
warning level.
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Configuring the Storage Server

● Enter the Storage Server Proxy Address

If the Storage Server needs to access
Camera Servers outside the LAN, you
may need to configure proxy settings. 

* See “When using a proxy server” (→ P. 14).

In the Storage Server Proxy field,
tick the Enable the following
proxy server box.

Enter the Proxy server address
and Port.

For more information on proxy server usage, ask your System administrator.

2

1

● Enter Recorded Video Settings

Maximum retained history -
Tick the Maximum retained
history option and enter a value
from 1 to 999 and then select
Days or Weeks from the drop-
down menu.

Maximum file size/duration -
Tick the Maximum file size/
duration option, enter a value,
and select MB or Hours. You can
enter 32 - 1024 for MB and 1 - 24
for Hours. This will establish the
maximum size used for each file of
recorded video. If you do not enter
a value, 1024 MB or 24 hours is
used for the Maximum file
size/duration value.

2

1

Low disk space warning level - Enter a percent value. When remaining space
reaches, for example, 10%, a notification will be emailed (→ P. 32).

Reduce recording frame rate when disk is under high load - When disk is highly
loaded, recording frame rate is temporarily reduced to prevent the recording from
stopped. Refer to “Administrator’s Manual” for details.

4

3

When Reduce recording frame rate when disk is under high load
is ticked, you will receive an event notification such as
“Recording rate (<rate before change> → <rate after change> %)”.
Ex. “Recording rate (100.0 → 90.0 %)”

Tip



27

Configuring the Storage Server
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● Select Disk Drive Settings

In the Disk drive settings field,
set: Drive - Select the disk drive
to configure, from the drop-down
menu.

Maximum disk space used -
Tick the box and enter a value in
Megabytes (MB) or Gigabytes
(GB), for example, “50 GB”.

This establishes the maximum
disk space used for all video
files on the specified drive.

2

1

Add Network Drive - Add a disk drive on the network used as the network drive.
The added network drive is shown on the Drive drop-down menu.

Delete Network Drive - Delete an added network drive.4

3

● Adding Removing a Network Drive

By adding a network drive, you can save recorded vided data on a network drive such as
NAS (Network Attached Storage) in addition to the internal HDD.

If you add a network drive in the Storage Server Configuration window, the drive will be
added to the list of the pull-down menu of the Add/Edit Camera Server dialog (➝ P. 62).

When using the Storage Server with the local system account,
the Add Network Drive and Delete Network Drive buttons are
disabled.Tip

To add a network drive...

Click Add Network Drive.1

� A NAS server cannot be used if you are using Windows 2000.
� Use recommended NAS servers with Windows Storage Server

2003 or Windows Storage Server 2003 R2.
Note
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Configuring the Storage Server

To remove a network drive...

Select a network drive and click OK to delete
the selected drive from the Storage Server.

The Add Network Drive appears. Select
a drive to add as a network drive and
enter a path assigned to the drive.

When selecting a folder with Browse... 

Click Browse..., select a folder where you
want to save recorded video data in the dialog
that appears, and click OK to enter the path
of the selected folder in the path field.

Enter the user name and password to access the network drive in the respective
fields, and click OK.

Be sure to use different user name and password from the logon user name and
password for the local system account.

If addition is successful, the added drive appears on the drive selection pull-down
menu.

3

2

� About Network Drive
VK-64/VK-16 can record videos on a drive on the network. The
drive type is shown at the head of the Drive drop-down menu
as “Internal disk: local, Network drive: network”.

Note
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Configuring the Storage Server

● Start or Stop the Storage Server Program

Click Stop Storage Server to stop the
Storage Server.

Click Start Storage Server to start the
Storage Server.

If you need to stop the Storage Server Program first inform all
users connected to the storage server.

Tip

� About Video Recording
If disk space is not enough to cover the specified value
configured with Maximum disk space used, the retained
duration of recorded video may be shorter than the specified
period or the recording may be temporarily stopped. Please be
sure to perform sufficient tests before starting operations.

� For details about disk space on the Storage Server, refer to
“Administrator’s Manual”.

� Windows does not allow a user who has logged in with a local
system account (used for normal service management) to add a
network drive. The Add network drive and Delete network drive
items are disabled while you are logging into Windows with a
local system account. To set the network drive, click Stop
Storage Server to stop the Storage Server, and click the Logon
Settings and switch to an account which is allowed to use the
network drive (i.e., account with Windows’ Administrator and
Logon As Service privileges). Refer to P. 31 for the Logon As
Service privilege.

� You cannot use a UNC path or removable disk when adding a
network drive.

� If you add or delete a network drive, the Storage Server
program will reboot.

� Multiple Storage Servers cannot use the same network drive
simultaneously.

� Single network drive cannot allocate to multiple drives.
� Internal information (thumbnails, location, zone, and recording

schedules) related to a network drive will not be lost even if
the network drive is deleted. Therefore, if you add the same
network drive later, you can restore the status before deletion.

� If the selected network drive cannot be accessed because the
network is disconnected, the selected drive is powered off, or you
entered a wrong path, the following error message will appear.

“Network path cannot be found.”
� While the network drive is not operating (e.g., due to network

disconnection), video will not be recorded until the drive
recovers.

� If a storage server is booted when the storage server is unable
to connect to a NAS server, video image data won’t be written
to or recorded data won’t be read from NAS server even after
the NAS server recovers. In such case, reboot the storage
server.

Note
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Configuring the Storage Server

Message

● When you have changed items affecting recording settings:

When you click Apply or End, the following message will appear.

“Item affecting recording setting has been changed.

To see how setting is affected, use Recording Setting Summary Display in the Recording
Schedules window of the Viewer.”

● When you have changed the Maximum retained history setting:

When you click Apply or End, the following message will appear.

“Changing the maximum retained history may delete recorded video. Are you sure to
continue?”

● When you have added or deleted a network drive:

When you click Apply or End, the following message will appear.

“Drive configuration has been changed and Storage Server must be restarted. Are you
sure to restart Storage Server?”

● Change the Logon Settings

If you need to log onto the
Storage Server with another
account when using a network
drive, cl ick Stop Storage
Server. After the Storage Server
stops, click Logon Settings.

The Log on as dialog appears.

If you are logging onto the
Storage Server with a local
system account, select Local
System account . If you are
logging onto the Storage Server
with another account, enter the
account in This account and
password in Password.

Click OK.

Click Start Storage Server to start the Storage Server with the specified account.4

3

2

1

If you are using VK-64/VK-16 with NAS server, you need to set up
log-on settings again after upgrading VK from v1.3 to v1.4.

Note
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Logon As Service Privilege
When you want to add the Logon As Service privilege to an existing Windows account so
that you may be able to configure network drive settings, perform the following steps
before configuring the logon settings.

Select Control Panel, Performance and Maintenance, Administration Tool, and
Local Security Policy from the Windows’ Start menu.
The Local Security Settings dialog appears.

Select Local Policy and User Privilege
Assignment from the tree to the left.

Double-click Logon as Service from
the list to the right.
The Logon as Service Properties
dialog opens.

Click Add User or Group.
The Select User or Group dialog
opens.

Enter the Windows account in the
Enter object name to select field.
Enter or change the object name,
location, and details as required.
Be sure to enter a Windows account
with Administrator privileges.

Click OK.
The Logon as Service Properties
dialog reappears.

Click OK.
The Local Security Settings dialog reappears.

Close the Local Security Settings dialog.
8

7

6

5

4

3

2

1
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Setting up Event Notifications

Enable email notif ication and select a
priority. Events of that priority and above will
lead to notification emails.

Select a suitable event priority from the
drop-down menu for each event type listed.

The priority of an event created by a
manual recording using Record Now will
always be Priority 1. The priority cannot be
changed from this dialog.

The events associated with “Recording
engine started”, “Data file set” and “User
log in” do not appear in a Viewer’s
Timeline, Live Events Log or Event Search
Dialog. Refer to “Viewer Manual” for the
details.

Enter the email subject line, for example,
‘Immediate Action Required’. Enter the
address of the recipient and enter your
from address.

Enter a Host Name or IP address and Port
Number of mail server for outgoing mail.

Enable authentication (POP-before-SMTP)
for connection and enter User Name,
Password and POP Server details.
If this is enabled, the Storage Server will
attempt to perform a POP login before
sending email that may be required for
some SMTP servers.

Set up a user to receive Event Notification emails
The Storage Server Configuration dialog, Events and Event Notification tabs allow
you to set up event priorities and email notification to a particular user.

● Adjust settings for the “Events” tab and “Event Notification” tab.

You can only register one e-mail address in the To Address field.
If you want to send the e-mail to multiple addresses, use a group
address.Tip
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Setting up Event Notifications

Example event notification email

An event of priority 3 occurred on 12/05/2006 at 15:15:17 PM +1000.

Parking Lot 1: Sensor on
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Adding and Editing Users
The Storage Server Configuration dialog, User Management tab allows you to set up
users and their privileges. Administrators have access to the Viewer including Camera
Server setup, recording schedules and Viewer setup. Operators only have access to live
video and recorded video on Storage Servers they have permission to access.

The User Management tab is laid out in the following manner:

● Users list - Lists all users who can access the Storage Server.

● Add / Edit / Remove - Allows you to add users, edit passwords and remove users.

Setting up Users

Tick to enable user to have
Administrator privileges
(full access to configuration functions).

If the Authentication is required
when starting this tool. box is
checked, the Login dialog opens. 

Use Add to add users to this field.
There is no limit to the number of users
you can add.

Click Apply to save changes.

● Users who have Operator status cannot configure, register
and change Camera Servers, or configure and change
recording schedules.

● By default, a user called “admin” is created. The password is
“NVR”. It is strongly recommended that this is changed after
installation.

● It is necessary to set up users on all Storage Servers. A
particular user should be set up to have the same password
on each Storage Server.

Note
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User Management tab - Add Users
The Add User dialog is used to add new users to the system. To add a user:

● Step 1: Click Add

In the User Management tab, click
Add to bring up the Add User dialog.

Setting up Users

● Step 2: Enter user details

In the Add User dialog, enter the
following details:

Enter the user’s User Name (up
to 20 characters, including alpha-
numeric letters and underscore
“_”).

Enter the password in Password.
The Confirm Password field
will become active. Re-enter the
password (up to 20 characters,
including alphanumeric letters
and underscore “_”).

Click OK when finished. The
dialog closes and the new user
is displayed in the User List.

3

2

1

The VK-64/VK-16 Administrator status is independent of the
Windows Administrator status.

Note

● Step 3: Assign user status to Administrator if necessary

In the user list under Administrator,
tick the box to give the user full
access to Network Video Recorder
Configuration function, otherwise
leave unchanged.

Click Apply to save changes.2

1
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Setting up Users

User Management tab - Edit Users
Use the Edit Users dialog to edit the password for an existing user. To edit a user:

● Step 1: Click Edit

Click a user entry in the user list
to select it.

Click Edit below the user list to
bring up the Edit User dialog.

2

1

● Step 2: Enter user details

In the Edit User dialog, enter the new
password for the user (up to 20
characters, including alphanumeric
letters and underscore “_”). The
Confirm Password field will become
active. Re-enter the new password.

Changes are kept when you click OK.

User Management tab - Remove Users

● Remove Users

Click a user entry in the user list
to select it.

Click Remove.2

1



Chapter 3
Starting the Viewer

This chapter describes how to start and login to
the Viewer and connect to the Storage Server.
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localhost
Connects to Storage Server
and starts the Viewer.
Select this option to use
the local PC where Viewer
is installed as the Master
Storage Server.

Launching Procedure
Double-click the VK Viewer desktop icon.

Alternatively, from the Windows Start menu select: Programs > WebView
Livescope > Network Video Recorder VK Series v1.4 > VK Viewer.

The connect option menu (Start-up Screen) is displayed. Select Master Storage Server option and

click Connect.

Start-up Screen

Starting the Viewer

Use IP address
Connects to Storage Server
and starts the Viewer by
specifying its IP address.
Select this option when the
Storage Server and the
Viewer are installed on
separate PCs. 

Not use Storage Server
Select this option to use
the Viewer only without
connecting to a Storage
Server.

If you want to add a Storage Server to the connect option menu,
login the Storage Server of your choice and click Add Storage
Server in the Viewer Settings window (→ P. 117).Note

● If multiple Storage Servers are being used, you should decide
which one is the Master Storage Server. 

● If the Storage Servers v1.2, v1.3 or v1.4 coexist, either Storage
Server can be specified as the Master Storage Server. 

● The Viewer v1.0, v1.1, v1.2, or v1.3 cannot connect to the
Storage Server v1.4.

● If you want to connect to the Storage Server directly without
displaying Start-up Screen when launching, untick When
starting, Master Storage Server is selected in the Viewer
Settings window (→ P. 117).

Tip
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Connect to the localhost
If you want to use the local PC where Viewer is installed as the Master Storage Server,
select localhost to start the Viewer.

Select localhost from the
drop-down menu.

Click Connect.

Enter your User Name and
Password, and click Login.

3

2

1

● The default user name and password are as follows:
User name: admin
Password: NVR

It is strongly recommended to change the user name and
password after installation.

● The Viewer can be launched directly without displaying Start-
up Screen and Login dialog. Refer to “Administrator’s Manual”
for details.

Tip
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● If you need to use a proxy server, you need to change the
Internet option settings in the following procedure:
1. Select Start > Control Panel > Internet Option.
2. Select the Connection tab.
3. Click LAN settings ….

Change the proxy server settings.
● If using a proxy server between a Viewer and a Storage Server,

it should be one which does not perform response buffering.
Proxies which are configured to perform response buffering
may lead to delays in sending small amounts of data (such as
events) from the Storage Server to the Viewer. The Apache
proxy server does perform response buffering so is not
recommended.

● You cannot transmit or receive audio when using a proxy
server.

Note

Starting the Viewer

Specify the IP address of Storage Server to connect Viewer
If you installed the Viewer and Storage Server on separate PCs, specify an IP address of
Storage Server and connect Viewer to the Storage Server.

If you are unsure of the address to use, ask your System Administrator.

Select Use IP address from
the drop-down menu.

Click Connect.

Enter the IP address or host
name of the Master Storage
Server in Host Name or IP,
and the port number in Port.

Click Connect.

Enter your User Name and
Password, and click Login.

5

4

3

2

1
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The dialog for entering the IP address will also be shown even
when connection to the Storage Server failed.

Tip

Starting the Viewer

Use Viewer only without connecting to Storage Server
(Viewer Only Mode)
You can use the Viewer only without connecting to a Storage Server. When Storage
Server is not used, some functions such as video recording, sensor events, motion
detection, and event search are not available.

Select Not use Storage
Server from the drop-down
menu.

Click Connect.2

1
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● Viewing Screen

● Timeline is not displayed. Timeline under the View menu cannot be used.

● Capture Still Frame feature cannot be used.

● Search Events under the Edit menu cannot be used.

● Live Events under the View menu cannot be used.

● Shared Layouts are not displayed.

● In the Add Layout Sequence dialog, a type of layout is fixed to Personal Layout
Sequence.

● Configuration and Preference Screen

● Recording Schedules tab is not displayed (→ P. 75). Some functions such as video
recording, sensor events, and motion detection are not available.

● In the Storage and Camera Server Summary, Storage Servers tab is not displayed
(→ P. 52).

● In the Storage and Camera Server Summary, the Camera Server list shows only
Camera Server, Locations / Zones and Type (→ P. 53).

● In the Add Camera Server and Edit Camera Server dialog (→ P. 62), the following
items are gray (disabled):
● Save Recorded Video on
● Camera Server Settings
● Camera Settings > Save video in

● In the Viewer Settings window (→ P. 116), items in the Event Notification Settings
area are gray (disabled).

Functions not Available during Viewer Only Mode (Not Use
Storage Server)
When you launch the Viewer with Viewer Only Mode, the following functions are not available.



Chapter 4
Overview of Viewer

Configuration
This chapter gives a brief overview of the Viewer Configuration process

(which is outlined in Chapters 5 to 7).
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When the Viewer accesses a Master Storage Server which has not been set up with
camera information, the entire Viewing Screen is initially blank. You will need to configure
the Viewer using the Configuration and Preferences screen.

After the Viewer has launched...

It is recommended that only one Administrator perform
configuration on a network at a time.

Note
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Accessing the Configuration and Preferences screen
To open the Configuration and Preferences screen:

● In the Menu Bar, select View → Configuration

The menu bar is located at the top left of the Viewing
Screen.

In the Menu Bar, select View → Configuration.

The Configuration and Preferences screen opens
with the Storage and Camera Server Summary
window displayed.

An example configuration is shown below.

A configuration process diagram is given on the following pages. Configuration is
discussed thereafter. When you have finished configuration, select View → Viewing
Screen to return to the Viewer. 
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After configuring the Storage Server and launching the Viewer, you are now ready to
configure the Viewer for monitoring, recording and playing back video. The flow diagram
below shows the Viewer configuration process via the Configuration and Preferences
Screen.

System Configuration Process

Register Storage and Camera Servers1
The first step is to register Storage
Servers and Camera Servers with
the Viewer. You will also need to
create Locations and Zones.

These tasks are done in
the Camera Summary
window.

For recording video, set up Normal and Special Day
Recording Schedules in the Recording Schedules window.

Set up Recording Schedules2
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Create and Save Viewer Layouts4

Set up Viewer Settings (optional)3

Monitor l ive video and
play back recorded events
in the Viewer. From here
you can customize the
Viewing Area and save
Layouts.

In the Viewer Settings window, you can adjust live viewing
frame rate, identify an individual Viewer’s Master Storage
Server, and set priorities for event.

Recorded video from
Storage Server

Live video from
Camera Servers
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Configuration and Preferences screen

About the Configuration and Preferences screen
The Configuration and Preferences screen is used for configuring one or more Storage
Servers and for setting up preferences on a Viewer computer. Storage Servers may
include the local computer being used or another computer on the network.

There are three windows in the Configuration and Preferences screen used for
connecting and configuring VK-64/VK-16 settings:
● Camera Summary - add a new Camera Server to a zone and search for existing 

Camera Servers on the network. This is discussed in Chapter 5.

● Recording Schedules - set up recording schedules for each known camera and
specify events for triggering recording. You can also set special day schedules such as
public holidays and display summary of settings. This is discussed in Chapter 6.

● Viewer Settings - set up event priorities and change the live video frame rate. The
current Master Storage Server is indicated. This is discussed in Chapter 7.

Selecting a window in the Configuration and Preferences screen
When the Configuration and Preferences screen is launched, three tabs are displayed.
The default selection is the first tab, the Camera Summary window.   

Click another tab to bring up 
the corresponding window.



Configuration and Preferences screen
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Chapter 5
Register Storage Servers and

Camera Servers
This chapter outlines how to register Storage Servers and Camera Servers

and to manage Locations and Zones.
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About Storage and Camera Server Summary Window
Clicking the Camera Summary tab opens the Storage
and Camera Server Summary window.

The window consists of two sub-windows which are
opened by their respective tabs, Storage Servers and
Locations / Zones.

Camera Summary Window

When the
Storage
Servers tab
is selected

When the Locations / Zones tab is selected

Click and drag scrollbar(s) to view any portions of the
Summary Area that are not visible.

Tree area Summary Area

→ P.56

→ P.58
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Camera Summary Window

Click and drag divider line to the right to reveal full values.

Storage Servers and Locations / Zones options
The following options are available via the Storage Servers tab:

Add Storage Server - Allows you to register a
Storage Server with the system (up to ten
Servers are recommended).

Edit - Allows you to change the address of
the selected Storage Server.

Select a Storage Server from the tree in the left panel. The right panel will update with a list
of Camera Servers recorded by the Storage Server you selected.

The following options are available via the Locations / Zones tab:

Add Location - Allows you to add a new
location to the system.

Add Zone - Allows you to add zones to
locations.

When you select a zone within a location in the left panel, a list of cameras in that zone is
displayed in the right panel.

Other Functions in Both Tabs

Camera server functions are located on the right-hand panel regardless of which tab is
selected:

● Find Camera Servers - Allows you to initiate a network search for unlisted camera
servers on the LAN.

● Add Camera Server - Allows you to add a new Camera Server to the system.

● Edit Camera Server - Allows you to edit an existing Camera Server’s settings.

● Remove Camera Server - Allows you to remove a Camera Server from the system.
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About Locations and Zones
Cameras are grouped into Locations and Zones. Locations could include an office
building, shop or school. Zones are a part of Locations, that is, a zone could be assigned
to each floor in the office building and specific areas in a shop such as a cash register.

The diagram below illustrates an example of physical Locations and Zones on a VK-
64/VK-16 network. Viewer access is via the Location and Zone drop-down menus.

Location and Zone

Zones are different areas of the one Location.

Location 2

Zone 4 Zone 5

Zone 6

Location 3

Zone 7

Zone 8

Location 1 (Shopping Mall)

Zone 1

Zone 3

Once configured, Locations and Zones are
selected from the Viewing Screen Camera
Selection area. When you select other
locations, their Zones become accessible.

Zone 2
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Location and Zone

When a Location is selected from the drop-down menu at left, all of the Zones associated with the
Location will appear to the right as camera thumbnail images.
This tab containing four thumbnail images indicates that there are four cameras in the Zone.

This tab containing six thumbnail images indicates that there are six
cameras in the Zone.

● The Location/Zone hierarchy is independent of the grouping
of cameras into Storage Servers. For example, a single Storage
Server may record video from multiple Locations, and cameras
from a single Location can be recorded to multiple Storage
Servers.

● When more than one Storage Servers are used and the
Storage Server configuration is changed after Camera Servers
are registered to Storage Servers, thumbnails of registered
Camera Servers may not be displayed. Register the Camera
Servers again.

Note
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Camera Summary - Add, Edit and Delete a Storage Server
If you are using multiple Storage Servers, add each Storage Server as directed below.
You need not perform these steps if you are using only one Storage Server and that
Storage Server has already been added. 

By adding the Storage Server, you can select the Camera Servers managed by the
Storage Server from the Viewer screen.

● Add the Storage Server

In the Camera Summary window,
select the Storage Servers tab.

Click Add Storage Server.

The Add Storage Server dialog opens.

Enter connection settings
and click OK.

3

2

1

Configure Camera Summaries

● Do not add the same Storage Server more than once.
● If you add a Storage Server with a different configuration

(such as one managed by another Master Storage Server),
your original Locations and Zones will be lost.

● If you are using Windows XP SP2 or Windows Server 2003, you
need to change Windows settings. Make sure to change the
settings. Refer to “Administrator’s Manual” for details.

● Do not change the port number.

Note

You can operate VK-64 with up to ten Storage Servers using any
Up to 192 Camera Servers can be operated.

Tip

If you are using the Viewer only, the Storage Servers tab is not
shown and you cannot add the Storage Server.

Note
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● Edit the Storage Server

Double-click the Storage Server in the list.

Alternatively, select the Storage Server and
click Edit.
This will bring up the Edit Storage Server
dialog.

Modify the entry and click OK to close and save changes.2

1

If a Storage Server is deleted, all Location, Zone, thumbnail and
Layout information for cameras associated with this Storage
Server will be lost.Note

● Delete the Storage Server

Click a Storage Server in the list to highlight it and select Delete from the Edit
menu. Alternatively, press the Delete key on your keyboard.

A confirmation dialog will appear. Click Yes to continue. 

Click No to cancel deletion.
2

1

● This function lets you change the network address used to
access a particular Storage Server in case the IP address has
changed.

● The Master Storage Server cannot be edited.

Note

To save changes, click
Save Changes at the
bottom right-hand corner
of the Camera Summary
window.

Click Discard Changes
to cancel any changes
you have made.

3
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● Step 2: Click Add Zone on the Locations / Zones tab

In the Camera Summary window,
select the Locations / Zones tab if it is
not already selected.

Click Add Zone.

The Add Zone dialog opens.

Enter the name of the new
zone (up to 20 characters).

Select a location from the
drop-down menu in the
Location field, then click
OK.

The selected zone will now
appear in the specif ied
Location folder.

4

3

2

1

Configure Camera Summaries

Camera Summary - Add, Edit or Delete a Location/Zone
You can easily add a new location to your system, then add zones to the new location
folder. For example, a location could be a supermarket and zones inside that location can
include cash register areas, supermarket aisles and entrances.

● Step 1: Click Add Location on the Locations / Zones tab

In the Camera Summary window, select
the Locations / Zones tab if it is not
already selected.

Click Add Location.

The Add Location dialog opens.

Enter the name of the new
location (up to 20 characters),
then click OK.

3

2

1



59

5

R
egister

S
torage

S
ervers

and
C

am
era

S
ervers

Configure Camera Summaries

● To edit a Location or Zone:

Double-click a Zone or Location.

The Edit Zone or Edit Location dialog opens.

Enter connection settings and click OK.2

1

● If you want to add a Zone to another location not listed, you
must first create the Location before you add the Zone.

● Each Location name must be unique and each Zone name
within a Location must be unique.

● There is no fixed limit on the number of Zones and Locations
that can be added.

Note

● To delete a Location or Zone:

Click a Storage Server in the list to highlight it and select Delete from the Edit
menu. Alternatively, click a Zone or Location to select it, then press the Delete key
on your keyboard.

A confirmation dialog will appear. Click Yes to continue.

Click No to cancel deletion.
2

1
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The camera names listed are those specified by the Camera Server.
Refer to the Camera Server’s User’s Manual for more information
on setting the name (“Camera Name” for VB-C50i/VB-C50iR, VB-
C50FSi, VB-C50Fi and VB-C10/VB-C10R, “Device Name” for VB150,
“VB-C300NA” or “VB-C300PA” for VB-C300).

Note

For the Camera Servers which are already registered, “Registered”
is displayed in the “Register” column. The “Register” column for
unregistered Camera Servers are blank.Tip

Camera Summary - Find Camera Servers
You can easily locate and register Camera Servers via Find Camera Servers.

Configure Camera Summaries

When you initiate the Find Camera Servers function, your computer
searches the Viewer’s local subnet for all Camera Servers connected
to it. It will not find Camera Servers on a different subnet where a
Storage Server may be connected. These Camera Servers must be
added using Add Camera Servers (→ P. 61).

Note

● Step 1: Click Find Camera Servers

In the Camera Summary window, click
Find Camera Servers which is located
above the right-hand panel.

The Search Results dialog opens and a list of detected Camera Servers will appear.
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Configure Camera Summaries

● Step 2: Select a new Camera Server

In the Search Results dialog,
click a Camera Server in the
search results list to select it.

Click Add Camera Server....

This will bring up the Add
Camera Server dialog where
you can configure settings for
the Camera Server.

Alternatively, double-click an
item to bring up the Add
Camera Server dialog.

Using the Add Camera Server
dialog is discussed on the following
pages.

2

1

You can also launch the Add Camera Server dialog in the following manner:

Camera Summary - Add Camera Server
To register a Camera Server which cannot be found via Find Camera Servers.

Click Add Camera Server to bring up
the Add Camera Server dialog. This is
discussed on the following page.
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About the Add Camera Server Dialog
The Add Camera Server dialog’s appearance will depend on the type of Camera Server
connected.

Set up camera position and saved video
The Add Camera Server dialog allows you to set a camera thumbnail image for the
Viewer and to choose a Storage Server for recorded video.

The dialog shown below illustrates an example VB-C300 setup.

Using the Add Camera Server Dialog

Connection Settings Adjust camera angle Set backlight compensation.

● The Viewer cannot set the Camera Server name. It must be set
on the Camera Server. Refer to the Camera Server’s User’s
Manual for more information on setting the name (“Camera
Name” for VB-C300, VB-C50i/VB-C50iR, VB-C50FSi, VB-C50Fi
and VB-C10/VB-C10R, “Device Name” for VB150. The sensor
name is “External Device Name” for VB-C50i/VB-C50iR, VB-
C50FSi and VB-C50Fi, “External Device Input Name” for VB-
C10/VB-C10R and VB150).

● Recording schedules must be set in order to record video. Clicking
OK does not immediately start recording video.

Note

Select a drive on the Storage
Server to save video.

Select a Storage Server to save
video from the camera. Selecting
Do not record prevents video
from being recorded.

One or more tabs
may show depending
on the type of the
Camera Server.
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Using the Add Camera Server Dialog

Add a Camera Server - Set connection details
To add a Camera Server, you must specify how VK-64/VK-16 can connect to the camera
server as follows:

● Step 1: Enter Host Name, User Name and Password

Enter the Host Name or IP address
in Host Name or IP, then enter
the port number for the Camera
Server in Port.

Enter the user name in User Name
and password in Password to
connect the Camera Server. The
settings are then saved to the
Storage Server.

2

1

● Step 2: Click Connect

Click Connect when you have added the above information.

Once the Viewer has connected with the Camera Server, a tab is shown next to the Add
Camera Server dialog.

● You must click Connect before clicking OK to close the dialog
(the OK button is disabled until you do so).

● When two or more cameras are used with VB150 (when “Video
Input” is set to “Single”), two through four tabs are added. The
number of tabs shown for a VB150 does not indicate the
physical number of cameras connected. It indicates the
number of cameras which have been enabled using the VB150
Camera and Video Settings Page. Please refer to Chapter 3,
P. 36 of the VB150 User’s Manual for more details. 

● If “Video Input” is set to “Single” for VB150, the camera name
displayed as the Camera Server Name is the first camera name in
the server’s camera name list when “Use Camera” is selected on
the Camera and Video Settings Page. Therefore, it is recommended
that the Administrator should set the first camera name to be a
general name, applicable to the entire Camera Server.

● If you are using a VB150 with the “Settings Web page URL” other
than the default setting “admin”, a connection error occurs when
you click Connect. Restore the default setting and try again.

Note

This is the User Name and Password configured on the Camera
Server side, not your VK-64/VK-16. If you do not know your
Camera Server user name and password, ask your System
Administrator.

Note
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Using the Add Camera Server Dialog

● Step 3: Select the Storage Server for recording

Select a Storage Server from the
drop-down menu which lists pre-
configured Storage Servers and
enter the Host Name or IP address
in Host Name or IP and Port
number in Port.

If you do not want the Camera
Server to be recorded video,
select Do not record from the
drop-down menu of Storage
Server.

2

1

● Recording schedules must be set in order to record video.
Refer to Chapter 6 for how to set recording schedules.

● There is a maximum number of 64 Camera Servers that can be
registered on one Storage Server with VK-64 (or 16 cameras
with Network Video Recorder VK-16).

● If you have changed the Camera Server’s IP address, you also
need to change the host names in the Connection Settings
and Storage Server Settings dialogs.

Note

If you have a Multi-Terminal Module VB-EX50 unit plugged into a
VB-C50i/VB-C50iR/VB-C50FSi/VB-C50Fi and have configured the
“Use External Video Input”, video seen in the Viewer may be
taken from cameras connected to the Multi-Terminal Module.
Switch the video at the Admin Viewer as required.

Tip

● Step 4: Configure External Device Input

To switch On or Off the external device
input, tick the Invert the state of the
following external option.

* One or more inputs may show depending on the

type of the Camera Server. It is not necessary to

change this setting if it is not required.
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Using the Add Camera Server Dialog

● Step 1: Select a camera tab if available

Click a tab to display that camera’s
settings.

● Step 2: Assign a location and zone

You can change the name of
camera in the Camera Name field,
if necessary. The camera name of
Camera Server will not be changed.

In the Location f ield, select a
location for the camera from the
drop-down menu.

In the Zone field, select a zone for
the camera from the drop-down
menu.

If necessary, click Add... to add
another Location or Zone.

The Add Location or Add Zone
dialog opens.

Enter Location Name or Zone
Name and click OK.

When you add a Zone in the Add
Zone dialog, you must also add it to
a Location in the same dialog.

Select a location from the drop-
down menu.

Refer to P. 58 for how to add locations and zones.

3

2

1

Camera Summary - Edit Camera Server Settings
The right-hand side of the Add Camera Server dialog may show one or more enabled
cameras (depending on the type of Camera Server you are using). To edit settings:
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Using the Add Camera Server Dialog

● Step 3: Update and setup camera thumbnail for Viewer

In the Preview area, a camera view is
given. Click Update to grab a current
frame from the camera. Captured
image is shown in the thumbnail area,
and is used as the thumbnail image of
the Viewer screen.

If you are not happy with the frame,
click Start Control. You can then use
your mouse to redirect the viewing
angle and zoom in or out.

Move the mouse cursor around the image. Arrows
will appear and you can click and drag the cursor in
that direction. The preview will change accordingly.
When you move the mouse cursor to the center of
the image, a zoom in or zoom out control will
appear.

Hold down the mouse on “+” to zoom in. 
Hold down the mouse on “-” to zoom out. 

Choose a pre-defined camera position (if already configured) from the Preset Angle
drop-down menu.

3

2

1

Presets need to be configured in advance. Please refer to the
Camera Server User’s Manual for details on making camera
presets.Tip

If you want to change the thumbnail and the preview area is blank
(and the Update and Start Control buttons are disabled), click
Connect (located in the Connection Settings field).Tip

● For a VB-C50FSi and VB-C50Fi, only zoom is available.
● If a fixed camera or an external camera such as VC-C50i is

connected to VB-C50i, you cannot use pan, tilt, and zoom
operations.

Note
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● Step 4: Select a hard drive for saving video

In the Drive menu, select a hard disk
drive on the Storage Server.

Click OK when finished.

The Camera Summary screen reappears.

Using the Add Camera Server Dialog

Network drives registered via Storage Server Configuration are
also shown on the Drive drop-down menu. Refer to “Select Disk
Drive Settings” (→ P. 27) for the details.Note
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● Step 2: Click Edit Camera Server

Click Edit Camera Server to
bring up the Edit Camera
Server dialog. This dialog is
identical to the Add Camera
Server dialog (you can also
double-click an entry to bring
up the dialog).

Change the settings. Click
OK to close the dialog.

2

1

Camera Summary - Edit Camera Server
The right-hand portion of the Camera Summary window features Edit Camera Server
for editing the Camera Server(s) on your system, regardless of which tab you have
selected (Storage Servers or Locations / Zones). The same dialog as Add Camera
Server (→ P. 62) opens.

● Step 1: Select a Camera Server

In the Camera Server list, click a
server to highlight it.

Edit and Remove Camera Servers
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Camera Summary - Remove Camera Server 
The right-hand portion of the Camera Summary window features Remove Camera
Server for removing the Camera Server(s) from your system, regardless of which tab you
have selected (Storage Servers or Locations / Zones).

● Step 1: Select a Camera Server

In the Camera Server list, click a
server to highlight it.

● Step 2: Click Remove Camera Server

Click Remove Camera Server
(you can also press the Delete
key on your keyboard).

A confirmation dialog will
appear. Click Yes.

Click No to cancel.

2

1

Edit and Remove Camera Servers

If a Camera Server is deleted, all the settings for VK-64/VK-16
associated with this Camera Server will be lost. Make sure to
change the settings.Note
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Saving Configuration Changes

Camera Summary - When you have finished configuration

● Click Save Changes to keep all your settings.

● Click Discard Changes to cancel any modifications you have made.

If you want to return to the Viewer dialog, select View > Viewing Screen from the menu
bar.

The bottom right-hand
corner of the Camera
Summary window
consists of two buttons,
Save Changes and
Discard Changes.



Configuring Recording
Schedules

This chapter details how to configure recording schedules 
for cameras on the network.

Recording schedules are configured for recording videos 
by motion detection and by sensors.

Chapter 6

After setting the recording schedule, make sure to perform
tests under actual conditions.

Note

If you are using the Viewer only, 

you can skip this chapter.
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Basic Recording Setting
First you must specify “when” the camera should shoot “what” video.

Just by configuring these two settings, you can start recording video with other default
settings.

“When” - Select one from the following:

Specific day of the week (Normal schedule)

Specific day (Special Day schedule)

“What” - Select one or more from the following:

Record video throughout the specified time period (Continuous recording)

Record video by motion detection during the specified time period (Motion Detection
recording)

Record video by sensor during the specified time period (Sensor Event recording)

Day of the
week

Specific day

Continuous 
recording

Motion 
Detection 
recording

Sensor 
Event 
recording

1 When 2 What

Motion detection recording starts recording video only when a motion has been detected
within a preset detection area.

Sensor Event recording starts recording video only when a sensor input has occurred.

One recording schedule can have Continuous, Motion Detection,
and Sensor Event recording settings. You can record a Camera
Server continuously at 1 frame per second and, for example, set
recording to increase to 5 frames per second when motion
occurs.

Tip
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Basic Recording Setting Flow
Select “When” Screen

The setting window depends on how to set “when” recording video.

If you want to record video on a day of the week, specify the day of the week and time on
the Add/Edit Schedule Item dialog under the Normal Schedule dialog.

If you want to record video on a specific day, specify the day on the Special Day
Schedule dialog and specify the time on the Add/Edit Schedule Item dialog under the
Special Day Schedule dialog.

Day of the 
week

Specific day

1 When

Normal schedule

Special schedule

● Refer to P. 75 for how to use the Normal Schedule dialog.
● Refer to P. 103 for how to use the Special Day Schedule

dialog.
Tip
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Select “What” Screen

Select an option in the Recording Mode area on the Add/Edit Schedule Item dialog under
the Normal Schedule or Special Day Schedule dialog, depending on what to record.

For Normal 
schedule

For Special Day 
schedule

Continuous 
recording

Motion 
detection 
recording

Sensor 
Event 
recording

2 What

Select the recording mode and configure settings.

While only the frame rate (fps) needs to be set for the Continuously at Max, further settings
are necessary for the On motion detection and On sensor event on the Motion Detection
Settings and Sensor Event Settings dialogs (respectively) displayed by clicking
Settings... on the first dialog.

● If you want to sequentially configure recording settings as you
use the camera, first configure the Continuous recording.

● Refer to P. 85 for how to use the Motion Detection Setting
dialog.

● Refer to P. 91 for how to use the Sensor Event Settings dialog.

Tip
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About the Recording Schedules window - Normal Recording
The Recording Schedules window is used for configuring recording settings for each
known Camera Server on the network.

In the Configuration and Preferences screen, click the Recording Schedules tab and
ensure the Normal Schedule is selected.
The Normal Schedule consists of:

● Storage Server selector - Select the Storage Server to edit the recording schedule.
When the Recording Schedules window is first opened, the first Storage Server in the
list is shown with its associated schedule to the right.

● Schedule Area - Used to set up standard day-to-day recording settings of the system.

Configure Normal Recording

6
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Storage Server selector            Schedule Area
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Zone representing camera
areas in the Location

Location

Zone Camera schedule time bars

Time Scale  for schedules

● Selecting multiple items and dragging or moving

While holding down the Ctrl key, click on individual schedule items to select them.
You can adjust or move multiple schedule items to new positions by dragging them.

You can also create multiple camera schedules. This is discussed on the following page.

Click and drag the

vertical scroll-bar

downward to view

any other zones.

Click and drag the

horizontal scroll-bar

to the right to view

other schedule days.



● To edit and delete a recording schedule item:

Right-click the schedule and select Edit from the context menu,
or double-click the schedule. The Edit Schedule Item - Camera
dialog is displayed.

Both the Add and Edit dialogs are identical as shown on P. 78.

77
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Create, Edit and Delete Recording Schedule Items
To add or edit a schedule for a camera in a zone, you need to launch the Add Schedule
Item or Edit Schedule Item dialog respectively.

● Step 1: Change Storage Server if necessary

If you wish to display another Storage Server’s
schedule, click the Storage Server menu,
otherwise proceed to Step 2.

The menu may list more assigned Storage Servers. If you select another Storage Server,
the Schedule Area will refresh and associated schedule zones will be shown.

● Step 2: Create the recording schedule.

Click and drag a time period for a camera
name and release the mouse button. The Add
Schedule Item - Camera dialog is displayed.

You can also click and drag an area covering several
cameras to bring up the Add Schedule Item - multiple
cameras dialog. This allows you to easily set schedules for
multiple cameras. Once created, settings for each camera
can be customized.

Configure Normal Recording

Alternatively, right-click anywhere in the
Schedule Area alongside a camera name and
click Add Schedule... from the context menu.

Right-click the schedule and select Delete from the context
menu.
Alternatively, click to select the schedule, and select Delete
from the Edit menu or press the Delete key on your keyboard.
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Configure Normal Recording

● The minimum duration for a schedule item is 15 minutes.
● You cannot create overlapping schedule items.

Note

To edit the time only, simply click an existing schedule item and
drag the right or left boundary to lengthen or shorten the time
respectively. You can modify the time with the mouse by an
increment of 5 minutes. To modify less than five minutes, double-
click an item and edit the time in the Edit Schedule Item dialog 
(→ P. 77).

Tip

Configuration is discussed on the following pages.

Set start and end times and the day of
the week (➝ P. 79).

Set frame rate, enable Motion Detection
and sensor event recording (➝ P. 80).

Move the mouse cursor in the Preview
area to change the camera angle 
(➝ P. 66).

Set the preset camera angle and
backlight compensation (➝ P. 81).

Set the external device output (➝ P. 83).
* The number of external devices available

for setting depends on the type of the
Camera Server.

Set the Night Mode, resolution and
options (➝ P. 82).

Display the Top page of the Camera
Server after Internet Explorer launches.

Control the camera via the Camera
Control Panel.
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Add/Edit Schedule Item dialog - Schedule field
To set the schedule for a camera’s recording period:

● Step 1: Set the recording period

Click the t ime segments and
overwrite with desired time, or use
the up/down arrows.

● Step 2: Select the days for recording

In the Repeat on area, tick the days
you wish to repeat the recording
period you set in the Times area
above.

Configure Normal Recording

● If you have defined any special day schedules, such as public
holidays, such schedules will override normal schedule times
for the whole day.

● Times are given in 24 hours, for example 18:00 is 6:00 pm.
● If a Camera Server has been configured with Restrict Service 

Time, VK-64/VK-16 will not be able to record from the Camera
Server during restricted times.

● The time zone used for the recording schedule will be the time
of PC where the Storage Server is running.

● The Storage Server will adjust for Daylight Savings if
configured in the operating system.

Note

● An example time period could be for overnight recording such as
‘Start: 22:00 to End 08:00’.

● Click All Day if you want 24 hour recording. The Start and End
times will be set at 00:00 respectively.

Tip
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● Select Motion Detection or Sensor Event recording (optional)

Click the On motion detection
box if you want recording
activated when motion is
detected during this time
period.

Click Settings... to change the details.

Click Settings... to change the details of each recording mode (→ P. 85, P.91).3

2

1

Add/Edit Schedule Item dialog - Recording Settings field
To configure the Camera Server for recording:

● Step 1: Set the recording mode

Click the Continuously at
Max. box if you want to set
continuous recording for the
duration of the time period.

Select a frame rate for recorded video from the drop-down menu, or input a value
from the keyboard.

You can set the frame rate from 0.1 to 30 frames per second. The default is 5
frames per second.

2

1

Configure Normal Recording

● When the load on the storage server CPU and hard disk is
high, recording at the specified frame rate may not be
available, or the video recording may be interrupted.

● Higher frame rates for result in larger disk usage. Make sure
you have enough disk space.

● The frame rate specified is the frame rate that the Storage
Server will attempt to record, and may not be the actual frame
rate recorded. Factors such as the number of Viewers, load on
the Camera Server and the Storage Server, and network traffic
may reduce the actual frame rate recorded. Also, the
maximum frame rate for a VB-C10 configured with a resolution
of 640 x 480 is 10 frames per second, and for a VB150 with 4
cameras is 2-3 frames per second.

Note
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● Step 2: Choose a preset angle and adjust backlight compensation

In the Preview field a live preview is
given of the selected camera view
when connected.
Select a Preset camera position from
the drop-down menu of available
camera angles, to retain a live preview
from that angle.
Alternatively, move your mouse
pointer in the Preview area to display
controls and clicking to pan, tilt and
zoom (→ P. 66).

Tick Preset Tour to switch among multiple preset positions sequentially (VB-C300,
VB-C50i/VB-C50iR, VB-C50FSi, VB-C50Fi only). Click Settings... to specify the
order to switch among presets. Refer to P. 96 for how to set the preset tour.

Select On or Off from the Backlight drop-down menu (You can set the backlight
compensation to High, Medium, Low or Off for VB-C300, VB-C50i/VB-C50iR, VB-
C50FSi and VB-C50Fi).
Selecting Not Specified accepts whatever backlighting the Camera Server offers.

3

2

1

Configure Normal Recording

● Camera angle can be changed by moving your mouse pointer
in the Preview area to display controls. Click the controls to
pan, tilt and zoom (→ P. 66).

● After the camera has been controlled, the preset will be set to
Custom. The value this is set to will be the value used for
recording and the position set will be the position recorded. If
you set a preset position using the digital zoom of the VB-
C300, the viewing angle may be misaligned.

● If you select Not Specified the Storage Server does not attempt to
change the setting, rather it accepts whatever resolution/mode the
Camera Server offers. If the camera angle is changed from the
Viewer, the changed setting is used for recording.

● In the following cases the Storage Server records whatever
the Camera Server currently displays; 
- Multiple number of cameras are connected to VB150 with the

Video Input set to Single.
- VB-C50i/VB-C50iR, VB-C50FSi, VB-C50Fi with an external

camera connected and have configured the Use External
Video Input.

● During initializing the camera head position of VB-C50i/VB-
C50iR, the camera head moves to face front, and then moves
back to the current position. Please note that video will be
recorded during this time.

Note
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● Step 4: Configure Additional Options

To use the exposure, white balance,
and/or focus settings on the Camera
Control Panel, tick the corresponding
check box.

Select a Resolution for recording from the drop-down list. You can select from Low,
Medium, High or Not specified.

If you select Not specified, the Storage Server does not attempt to change the
setting, rather it accepts whatever Night Mode setting and resolution the Camera
Server offers.

2

● You can also configure the Night Mode setting if you use a VC-
C50i/VC-C50iR connected to a VB150. 

● The Top page of the Camera Server is displayed after Internet
Explorer launches. Please refer to the Camera Server User’s
Manual for details. You can edit an existing Camera Server’s
settings.

Tip

● If you select Enabled, the Night Mode status will be changed
to Disabled after the configured recording schedule finishes.

● A higher resolution results in larger disk usage. Make sure
you have enough disk space.

Note

● Step 3: Set the Night Mode and Resolution (VB-C300, VB-C50i/VB-
C50iR, VB-C50FSi, and VB-C50Fi)

Select the Night Mode from the
drop-down menu. You can select
from Not Specified, Disabled,
Enabled, and Auto (for VB-C300
only).

1

● The On motion detection, Backlight compensation, and
additional options are not available, if you use the preset tour
function.

● Preset used for the preset tour are created on the Camera
Server. Please refer to the Camera Server User’s Manual for
details on making camera presets.

● Although the VB-C300 does not allow preset tour on the
Camera Server, the preset tour is available via this setting.

Note
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If Setup... is clicked, click the drop-
down menu for the target external
device and set External Outputs to On
or Not Specified on the External
Outputs Setting dialog.

3

● The additional option is only allows to use with VB-C300.
Other models cannot use these options.

● If the Exposure box is ticked, the Backlight compensation
option will be disabled.

Note

● Add/Edit Schedule Item dialog - External Outputs Setting

Click the External Outputs
Setting to control any external
devices that may be connected
to your Camera Server.

Click Setup... to change the details of external outputs. Otherwise the default
settings will be used.

2

1

Click OK to save the new settings and close the dialog. 

Click Cancel to discard the new settings.

When you click OK, the Preset and Backlight settings are effective on Video Windows in
the Viewer. Control the camera as required by clicking Camera Control.

If you have not finished, proceed to the following pages which outline the dialogs used for
Sensor Event and Motion Detection recording.

Camera Servers have certain features to allow image capture 
operations based on sensor input or schedule. If settings are
enabled on the Camera Server, they take precedence over any
settings made in VK-64/VK-16. This may cause some confusion if
your VK-64/VK-16 recording schedules fail to record with the
correct camera preset. You should disable such Camera Server
features if you wish VK-64/VK-16 settings to take precedence.

Note

For the VB-C300, only one external device can be configured on
the Control External Devices dialog.

Tip
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Configure Motion and Sensor Settings

Recording Schedule dialog - Motion and Sensor Settings
The Motion Detection recording starts recording video when a motion has been detected,
while the Sensor Event recording starts recording video when a sensor input has
occurred.

In the Add / Edit Schedule Item dialog, there are two options available for setting
recording parameters. To enable recording options and adjust settings:

● Displaying the Setting Screen for Motion Detection and Sensor
Event Recordings

Tick each box to enable the functions.
Default settings are then enabled.

Click Settings... to change the details
of each option. This opens a new
dialog.



85

6

C
onfiguring

R
ecording

S
chedules

Configure Motion and Sensor Settings

Recording Schedule - Edit Motion Detection Settings
You can specify the detection area and the amount of sensitivity for Motion Detection
Recording. The area for detection can also be modified which is ideal, for example, if the
field of view has two entrances and you wish to monitor motion for one entrance.

● Step 1: Next to “On motion detection”, click Settings...

The Motion Detection Settings dialog
opens (The dialog for VB-C300 is
shown below).

● If Continuous and Motion Detection recordings are both set,
the pre-event recording is not available. 

● Camera Servers have certain features to allow image capture
operations based on sensor input or schedule. If settings are
enabled on the Camera Server, they take precedence over any
settings made in VK-64/VK-16, and your VK-64/VK-16
recording schedules fail to record with the correct camera
preset. You should disable such Camera Server features when
using VK-64/VK-16 to record images.

Note

Click and drag a
control point to
re-size the active
region.

Set a priority for events
triggered by motion.

Select sensitivity
options.

Select frame rate and pre/post event duration for
recording triggered by motion.

Motion detection
level indicator will
increase during
activity.

Click to activate motion detection on the Camera Server for
VB-C50i/VB-C50iR, VB-C50FSi and VB-C50Fi.

Activate external
outputs.
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● Step 2: Set the active region for recording

In the Active Region field, adjust the region where
motion detection is triggered. By default, the Active
Region is the full area. You cannot use pan, tilt,
and zoom operations in this window.

Click one of the corner or edge handles and
hold down the mouse button.

Drag the handle to change the motion-trigger
boundary (dotted frame); click the corners to
adjust the area or click the edge handles to
bring each side in or out respectively.

● Step 3: Set Motion Detection Options

Set the following options on the Motion Detection Setting dialog.

In the Detect Motion Using menu, select
one of the following:
Storage Server
Obtains video from the Camera Server and
detects motion with the Storage Server.
Camera Server
Uses the Motion Detection function of the
Camera Server to detect motion (This menu
is only active for VB150 servers with the
Video Input set to Single or VB-C50i/VB-
C50iR, VB-C50FSi, VB-C50Fi).

In the Analysis Frame Rate menu, select
from 0.1 to 30 frames per second.

If you select the Camera Sever to detect motion, Settings… becomes available. Click to
launch your VB Admin Motion Detection Setting Tool. You must have VB Admin Tools
installed in advance. Refer to the Camera Server’s User’s Manual for how to configure the
motion detection settings. Refer to the Administrator’s Manual for important information on
Camera Server-based motion detection.

2

1

2

1

Configure Motion and Sensor Settings

● To use the motion detection function of the VB-C50i/VB-C50iR,
VB-C50FSi and VB-C50Fi, it is necessary to configure schedules
from the “VB Admin Schedule Setting Tool”.

● Setting motion detection at the Storage Server causes high
CPU load. It is strongly recommended to set motion detection
at the Camera Server whenever it has the motion detection
function.

Note
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Configure Motion and Sensor Settings

The Motion Detection Options field also allows you to set the sensitivity for motion
detection within the Active Region. There are three controls, Sensitivity, Area Ratio and
Duration.

Motion detection status can be checked by the Detection Indicator.

Detection Indicator Colors

Motion is displayed in the Detection Indicator as a green color bar and will remain green
if the level of motion is below the set Sensitivity and within a defined Area Ratio. If motion
reaches the set Sensitivity and Area Ratio, the color bar changes to yellow and if the
detected motion remains at the yellow level for the defined duration, a red color bar is
displayed and an event is triggered. The behavior of the Detection Indicator is described
as follows.

● Green color bar - The area of change that is less than the
specified Area Ratio, i.e., activity remains at the left of the
Area Ratio marker.

● Yellow color bar - The area of change that is equal to or greater
than the specified Area Ratio (activity peaks on or to the right
of the Area Ratio marker) but the required amount of motion
has not met the specified duration in order to trigger an event.

● Red color bar - The amount of change that meets the defined
detection conditions and motion is detected, triggering an
event, i.e., the required amount of motion has been detected
for the specified duration.

Area Ratio slide bar.

Area Ratio marker.

Area Ratio marker.

Area Ratio marker.

Area Ratio marker.
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Configure Motion and Sensor Settings

● Set the Sensitivity

Sensitivity is the degree of change detected as motion.

Select Low-Med or Med-High. The
available sensitivity settings range from
1 to 256. 

You can specify 1 through 128 as
Sensitivity by clicking Low-Med and 129
through 256 by clicking Med-High.

Drag the slide bar to adjust Sensitivity to the desired value (depending on the
Switch Sensitivity setting).

● Set the Area Ratio

Area Ratio is the degree of change of area (ratio against the defined detection area)
detected as motion.

Click and drag the Area Ratio slide bar to any
position from 0% to 100%. This establishes
the proportion of image inside the Active
Region (dotted frame) allowed before motion
is detected.

When you drag the slide bar, the black vertical line in the Detection
Indicator will move to reflect the change in specified Area Ratio.

● Set the Duration

Duration is the length of time necessary for the change to be recognized as motion.

Click and drag the Duration slide bar to any
position between 0.0 and 5.0 seconds. This
establishes the duration of motion allowed
before an event is triggered. It also establishes
the period where there is no motion in order
for the event to be completed.

2

1

The Motion Detection settings are affected by the video quality
setting of the Camera Server. After configuring the Motion
Detection settings, do not change the video quality on the
Camera Server.

Note

Area Ratio marker.
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Configure Motion and Sensor Settings

● Step 5: Set frame rate and pre and post event recording duration

In the Record Video At field:

Max. Frame Rate - select a maximum
frame rate for recorded video from the
drop-down menu, or enter a value from
the keyboard. Choose from 0.1 to 30
frames per second (5 is the default).

Record for before event - enter a number of seconds for the amount of recording
time before the event occurs (up to a maximum of 30 seconds).

Record for after event - enter a number of seconds for the amount of recording
time after the event has transpired (up to a maximum of 999 seconds).

● Step 6: Set the External Outputs

Click the drop-down menu for
the target external device and
set On or Not specified.

1

3

2

1

● If Continuous Recording is also set, Record for before event is
not available.

● If Record for before event is set to one second or longer, it
may take approximately 10 seconds after event occurrence
until its display.

Note

● Step 4: Set the event priority status

In the Priority field, select the priority for the
event to be generated for this motion from a
menu of five options, ranging from 1. Highest
to 5. Lowest. Priorities are color-coded as
events in the Timeline in the Viewing Screen.
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If the before event and after event fields are set to 0 seconds,
video will still be recorded while motion is detected.

Note

Configure Motion and Sensor Settings

Click OK to save the new settings and close the dialog.
Click Cancel to discard the new settings.

● Available external outputs depend on the Camera Server.
● Certain Camera Servers have features to allow image capture

operations based on sensor input or schedule. If settings are
enabled on such a Camera Server, they take precedence over
any settings made in VK-64/VK-16. This may cause some
confusion if your VK-64/VK-16 recording schedules fail to
record with the correct camera preset. You should disable
such Camera Server features when using VK-64/VK-16 to
record images.

Note

Refer to the “Administrator’s Manual” for important information
on Camera Server-based motion detection.

Tip
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Recording Schedule - Edit Sensor Events Settings
You can specify recording settings based on the occurrence of a sensor event. A number
of tabs in the Sensor Event Settings dialog are shown to reflect the number of sensors
on each camera. You can modify the recording settings for each sensor.

● Step 1: Next to “On sensor event”, click Settings...

The Sensor Event Settings dialog opens.

Configure Motion and Sensor Settings

Click a tab to change the
sensor’s settings.
The sensor name
displayed is the name set
by the Camera Server.

The Top page of the
Camera Server is
displayed after Internet
Explorer launches.

Set whether or not to
use additional options
(exposure, white
balance, and focus).

Night Mode is available
for VB-C300, VB-
C50i/VB-C50iR, VB-
C50FSi and VB-C50Fi
Camera Servers or VC-
C50i/VC-C50iR cameras
connected to Camera
Server VB150s. Select
from Not specified, Day
Mode, or Night Mode. 

You can set External
Outputs to On or Not
Specified when a sensor
event occurs.

● Frequent sensor events result in high CPU load on the Storage
Server. If you have 10 or more sensor events per minute
continuously, we recommend continuous recording.

● Setting Night Mode to “Enabled” will activate the IR cut filter. It
will not turn on the built-in IR light. To turn on the IR light,
perform the operation from the Video Window menu.

Note

Control the camera via
the Camera Control
Panel.
Refer to the Viewer
Manual for the
information about the
Camera Control Panel.
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● Step 2: Set the recording and an event priority

Tick Record on this sensor to
enable recording when a sensor
is triggered.

In the Priority field:

Priority - select the priority for
the event to be generated for
this motion from a menu of five
options, ranging from 1. Highest
to 5. Lowest . Priorit ies are
color-coded as events in the
Timeline in the Viewing Screen.

2

1

● Step 3: Specify a camera angle when the sensor is triggered

In Camera Angle, select a preset
camera angle from the Preset drop-
down menu. When the sensor is
triggered, the camera will be changed
to this position.

If you select Not specified, the camera
will not be moved.

The camera angle can also be
changed by moving your mouse
pointer in the Preview area to display
controls and clicking to pan, tilt and
zoom (→ P. 66).

After the camera has been controlled,
the Preset will be set to Custom.

● Click the Backlight drop-down menu and select On to
compensate for camera views with strong backlighting. The
setting will be used when the sensor is triggered. This is
useful, for example, if a camera angle would change from an
indoor view to an outdoor view when the sensor is triggered.

● If you are using a normal close type sensor, you need to set
the presets with the Add Camera Server screen.  Refer to
“Configure External Device Input” (→ P. 64) for the details.

Tip

If you set a preset position using the digital zoom of the VB-C300,
the viewing angle may be misaligned.

Note
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● Step 4: Set the Night Mode (VB-C300, VB-C50i/VB-C50iR, VB-
C50FSi, and VB-C50Fi)

Select the Night Mode (→ P. 91) from
the drop-down menu. You can select
from Disabled , Enabled , or Not
specified.

● Step 5: Set Additional Options (VB-C300)

To use the exposure, white balance,
and/or focus settings on the Camera
Control Panel, tick the corresponding
check box.

● VB-C300 only allows these options to be used.
● If Exposure is set, the Backlight compensation option is set to

Not Specified.
Note

● Step 6: Set frame rate and pre and post event recording duration

In the Record Video At field:

Max. Frame Rate - select a
maximum frame rate for recorded
video from the drop-down menu,
or enter a value from the
keyboard. Choose from 0.1 to 30
frames per second (5 is the
default).

1

The frame rate specified is the frame rate that the Storage Server
will attempt to record, and may not be the actual frame rate used
for recording video. Factors such as the number of Viewers, the
number of Camera Servers used, network traffic and load on the
Camera Server and the Storage Server may reduce the actual
frame rate recorded.

Note
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Record for before event - enter a number of seconds for the amount of recording
time before the event occurs (up to 30 seconds).

Record for after event - enter a number of seconds for the amount of recording
time after the event has transpired (up to 999 seconds).

Click OK to save the new settings and close the dialog.

Click Cancel to discard the new settings.

3

2

Configure Motion and Sensor Settings

● If the before and after event fields are set to 0 seconds, video
will still be recorded while the sensor is activated.

● Longer pre-event recording will increase memory usage.
Longer pre-event recording with insufficient memory may
greatly reduce performance when the disk-based virtual
memory runs short.

● If Continuous and Motion Detection recordings are both set,
the pre-event recording is not available. 

● Even when Record for after event is enabled, the frame rate,
frame size and network delays may have an effect on when the
last frame is recorded and thus the full requested duration of
post event recording may not be available.

Note

● If Continuous Recording is also set, Record for before event is
not available.

● If Record for before event is set to one second or longer, it
may take approximately 10 seconds after event occurrence
until its display.

Note
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● Higher frame rates for “Max. Frame Rate” result in larger disk
usage. Make sure you have enough disk space.

● Camera Servers have certain features to allow image capture 
operations based on sensor input or schedule. If settings are
enabled on the Camera Server, they take precedence over any
settings made in VK-64/VK-16. This may cause some
confusion if your VK-64/VK-16 recording schedules fail to
record with the correct camera preset. You should disable
such Camera Server features if you wish VK-64/VK-16 settings
to take precedence.

Note

Configure Motion and Sensor Settings

If Setup... is clicked, click the
drop-down menu for the target
external device and set External
Outputs to On or Not Specified
on the External Outputs Setting
dialog.

3

● Step 7: Set the External Outputs

Click External Outputs
Setting to control any external
devices that may be connected
to your Camera Server.

Click Settings ... to change the details of external outputs. Otherwise the default
settings will be used.

2

1

Available external outputs depend on the Camera Server.
Note
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Setting the Preset Tour

● Setting the Preset Tour

Ticking the Preset Tour enables the
preset tour function. Default settings
are then enabled.

Click Settings... to change the
defaults. The Preset Tour Settings
dialog is displayed.

● The durability of camera Pan/Tilt mechanism may be affected
depending on the Preset Tour setting (➝ P. 99).

● In the preset tour, the camera position returns to the first
preset after the last preset.

● When the preset tour is used, the Motion Detection recording,
backlight compensation, and additional options are not
available.

● Presets used for Preset Tour are set on the Camera Server.
Please refer to the Camera Server’s User’s Manual for details
on setting camera presets.

Note

Recording Schedule - Preset Tour Settings
Use the preset tour function to move among multiple preset positions sequentially. 

In the Add/Edit Schedule Item dialog, there are two options available for setting the
preset tour function. To set the preset tour function:
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Setting the Preset Tour

● Test the Preset Tour

Click Start Test.

Clicking Start Test executes the preset tour once and you can check the operation.

● Change the Preset Settings

Select a preset to change from the list and click Edit....

The Preset Tour (Edit) dialog appears.

For the selected preset, change the Speed (PT), Speed (Z), and/or Pause (sec)
settings.

Drag the slide bar for each item to set the value.

Check the settings and click OK.

This returns to the Preset Tour Settings dialog.
3

2

1

1

For VB-C300, you can return the focus to the default setting by
ticking the “Focus is returned to default when the camera is
operated.” option.Tip

● Add a Preset

Click Add on the Preset Tour Settings dialog.

The Preset Tour (Add) dialog appears.

Select a preset to add from the
Preset drop-down menu.

For the selected preset, configure
the Speed (PT), Speed (Z), and
Pause (sec) settings.

Drag the slide bar for each item to
set the value.

Check the settings and click OK.

This returns to the Preset Tour
Settings dialog.

4

3

2

1
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Setting the Preset Tour

● Change the Preset Order

Select a preset to change the order from the list, and click Move Up or Move Down.

● Delete a Preset

Select a preset to delete from the list and click Remove.

Click OK.

This returns to the Preset Tour Settings dialog.
2

1



If the following warning appears, please consider changing the
settings according to the tables below.

Warning example

* The tour time shown depends on the settings.

Click Cancel to return to the setting screen.
Click OK to save the current settings.
(If you are using the Preset Setting Tool, click Save on the setting
page of the tool)

Endurance of the pan/tilt mechanism is approximately 100,000
round trips at the full range. The total tour time depends on the
combination of the movement rate, movement range, and still
time. Refer to the following tables.

Total tour time for 100,000 round trips in the pan direction
(estimated).

Example: If the movement rate (PT) is 1, still time is 30 seconds,
and movement range (angle) in the pan direction is 50
degrees, it takes approximately 9,444 hours for 100,000
round trips in the pan direction.

Note

Setting the Preset Tour
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Movement rate (PT) is 1.

Still time
Movement range in the 
pan direction (angle)

0

10

20

30

    50

3872

5666

7555

9444

    100

3825

4722

5666

6611

    150

3809

4407

5037

5666

(Unit: Time)

(sec.)

0

10

20

30

 
 

    50

1983

3777

5666

7555

    100

1936

2833

3777

4722

    150

1920

2518

3148

3777

Movement rate (PT) is 2.

Still time
Movement range in the 
pan direction (angle)

(Unit: Time)

(sec.)
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When you have finished Normal Recording configuration...

● Click Save Schedule to keep all your settings. The settings are then saved to the
Storage Server.

● Click Discard Changes to cancel any modifications you have made.

If you wish to return to the Viewer, select View > Viewing Screen from the menu bar.

Saving Normal Recording Changes

The bottom right-hand
corner of the Recording
Schedule window
consists of two buttons,
Save Schedule and
Discard Changes.
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Saving Normal Recording Changes

Display the Recording Setting Summary
Display the summary information of the set recording schedule.

Click Display Record Setup Summary to
display the Record Setup Summary
dialog.

The Recording Setup Summary dialog shows the following information for the time
period where the highest load is expected when the schedule is performed.

Number of Camera Servers
Number of Camera Servers with Motion Detection
Total Recording Frame Rate

Total Recording Frame Rate (Continuous Recording)
Total Recording Frame Rate (Sensor/Motion Detection Recording)

Maximum Retained History
Maximum File Size/Duration
Disk Space Used

Click OK to close the Recording Setup Summary dialog.

Display Record
Setup Summary is
located at the center-
bottom of the Normal
Schedule window. 
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Saving Normal Recording Changes

Click Copy to copy the contents of the Recording Setting Summary
dialog to the Clipboard.

Tip

If the load is too high, adjust the recording schedule again.
Note
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About Special Day Recording
The Special Day Schedule window is used for configuring particular days such as public
holidays. When Special Day Schedules are set, Normal Schedules that conflict with the
Special Day Schedules are disabled.

In the Configuration and Preferences Screen, click the Recording Schedules tab and
ensure the Special Day Schedule is selected. The Special Day Schedule consists of:

● Storage Server - Select a Storage Server from the list to add/edit schedules for that
server. Associated Locations and Zones are displayed in the Schedule Area.

● Schedule Type selector - Allows you to select a schedule type. These are user-defined
schedules such as Public Holidays and Long Weekends.

● Days selector - Allows you to choose a day to use this schedule.

● Schedule Area - Covers a single day, 24 hours. Overrides a Normal day schedule.

Configure Special Day Recording
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Configure Special Day Recording

Storage Server selector Single day schedule area (24 hours)

Zone representing camera

areas in the Location
Location

Schedule Type selector    

Day selector  
Click and drag the 

scroll-bar(s) to view more

schedules if necessary.

● The scheduling area functions the same as the Normal
Recording Schedule but only covers a single day (from 00:00
hrs. to 24:00 hrs). To have a special day schedule run over a
long weekend (Fri, Sat & Sun), all dates of three days must be
added to the list of days to use the schedule.

● When Special Day Schedules are running, Normal Schedules
are disabled. If an invalid schedule exists, the following
warning message will be displayed. “There is a camera with
no recording schedule. Are you sure to save the settings?”

Note
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Configure Special Day Recording

● Step 2: Enter a name 

Enter a name in the Schedule Name
area, for example ‘Company Holidays’
(You can use up to 20 characters).

Click OK.

The schedule type is added and the
dialog closes. 

The new name wil l  appear in the
Schedule Type list.

2

1

Add, Edit and Delete a Schedule Type
The Add Schedule Type dialog allows you to create a name for a new schedule type, for
example, a public holiday. You must create a schedule type first before you can associate
days with it. There is no limit to the number of schedule type that can be added.

To launch the dialog and add a schedule type:

● Step 1: Click Add... below the Schedule Type list

Click Add....
The Add Schedule Type dialog is displayed.
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Configure Special Day Recording

● Delete a Schedule Type

In the Special Day Schedule window, click a
schedule type in the Schedule Type list to
select it.

Click Delete.

The schedule type is deleted.
2

1

● Edit a Schedule Type

In the Special Day Schedule window, click a
schedule type in the Schedule Type list to
select it.

Click Edit....

This will bring up the Edit Schedule Type
dialog.

Overwrite the existing name. For example, you may
wish to change the name “Company Holidays” to
“Company Special Days”.

Click OK.

The new settings are saved and the dialog closes.

2

1

If you delete a schedule type where there are dates associated
with that schedule, a warning will appear. Delete the associated
dates before deleting the schedule type.Note
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Add and Delete a Day
The Select Date calendar allows you to select a day that can be used for the schedule
type. To add a day:

● Add a Day

In the Special Day Schedule window, click
a schedule type in the Schedule Type list,
for example, ‘Company Holidays’ (created on
P. 105) and then in the Days list click Add….

This will bring up the Select Date calendar
(see below).

Click to select a day in the calendar, then
click OK.

Click Add... again to add another day to the
same schedule type if you wish.

Added days are shown in the Days list (see
example on next page).

Other calendar selection methods are shown
on the next page.

2

1

Configure Special Day Recording

Click to scroll back

through the months.

Click to scroll forward

through the months.

Click a day to 

highlight it, then

click OK to

bring up that

day in the Days

list.
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● Delete a Day

In the Special Day schedule window, click  a
schedule type in the Schedule Type list, for
example, “Company Holidays” and then in the
Days list click one of the days associated with
the schedule type.

Click Delete in the Days l ist. The day is
deleted from the schedule type.

2

1

Configure Special Day Recording

● If you attempt to associate the same day with different
schedule type, you will be given a warning and asked to delete
the other entry before creating a new one.

● Expired days are listed in italics.

Note

Alternatively, click the current month
and a month selector will appear.

To select another year, click
the current year and scroll
down or back up, using the
up/down arrows.
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Saving Special Day Changes

When you have finished Special Day configuration...

● Click Save Schedule to keep all your settings.
The settings are then saved to the  Storage Server.

● Click Discard Changes to cancel any modifications you have made.

If you wish to return to the Viewer, select View > Viewing Screen from the menu bar.

The bottom right-hand
corner of the
Recording Schedule
window consists of
two buttons, Save
Schedule and
Discard Changes.
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Saving Special Day Changes

Display the Recording Setting Summary
Display the summary information of the set recording schedule.

Click Display Record Setup Summary to
display the Record Setup Summary dialog.

The Record Setup Summary dialog shows the following information for the time period
where the highest load is expected when the schedule is performed.

Number of Camera Servers
Number of Camera Servers with Motion Detection
Total Recording Frame Rate

Total Recording Frame Rate (Continuous Recording)
Total Recording Frame Rate (Sensor/Motion Detection Recording)

Maximum Retained History
Maximum File Size/Duration
Disk Space Used

Click OK to close the Record Setup dialog.

Display Record
Setup Summary is
located at the center-
bottom of the Special
Day Schedule
window. 
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Saving Special Day Changes

Click Copy to copy the contents of the Recording Setting
Summary dialog to the Clipboard.

Tip

If the load is too high, adjust the recording schedule again.
Note
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Checking Recording Status

Check the Recording Status
If you save the Normal or Special Day schedule settings, the Camera Server starts or
prepares for recording. 

The recording status can be checked on the Edit Camera Server dialog in the Storage
and Camera Server Summary screen.

● Check the Storage and Camera Summary windows

Start the Viewer.

Refer to Chapter 3 for how to start the Viewer.

In the Menu Bar, select View - Configuration.

The Configuration and Preferences screen appears.

Click the Camera Summary tab.

The Storage and Camera Summary windows appear.

In the Camera Server list, check the Record Mode, Status, Resolution, f/spec,
and Quality.

4

3

2

1

In the Status area, the following information is shown.
● Not Connected: 

A communication or connection error has
occurred. The error number is also displayed.

● Idle: Connection is established but no video is being
received.

● Monitoring:Video is being received but not recorded (This
status indicates that a schedule which enables the
pre-event recording and Motion Detection
recording by the Storage Server is running but the
video is currently not being recorded).

● Recording:Video is being received and recorded. The bit rate
for receiving video is also shown.

● Error: An error has occurred. Errors such as file write
error or invalid drive error are also shown.

● Disabled: The camera is invalid. If the Camera Server is set to
Do not record, this field is blank.

Tip
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Checking Recording Status

● Check the Edit Camera Server Dialog

Select the desired Camera Server from the Camera Server list, and click Edit.

The Edit Camera Server dialog appears.

Click Connect. 

This establishes connection with the Camera Server.

Select the desired camera from the Camera Settings tab in the right-hand area of
the screen. 

The Camera Settings tab opens.

Check the Preset Angle and Backlight compensation settings.4

3

2

1
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Configure Viewer Settings
This chapter outlines how to configure settings that are specific to the Viewer.

Chapter 7

After configuring the Viewer, make sure to perform
tests under actual conditions.

Note



About the Viewer Settings window
The Viewer Settings window is used for configuring settings such as notification priorities
and the live video viewing frame rate. Settings are stored on the Viewer PC, not on the
Master Storage Server.

This window consists of:
● Video Viewing Settings - Select the maximum viewing frame rate for live videos.

● Master Storage Server - The current Storage Server is indicated.

You can switch to display or not to display the Master Storage Server option window
(connect menu) on start-up, and also add/delete Master Storage Server into/from the
connect menu.

● Proxy Setting - Use this option to make an access to Storage Server via proxy server.

● Layout setting - Confirm if the layout was preserved when quitting or when the screen
changes.

● Event Notification Settings - Set operator notification and adjust duration in seconds,
set operator acknowledgement (recognition) of an event, set an audio alert, and
suppress event display.

● Audio Setting - Set automatic termination of audio transmission after a specified period
of time.

● Focus Operation Setting - Set the focus position to return to the default setting of the
camera when operating the camera.

116

Configure Viewer Settings

Click the Viewer Settings tab to
display the Viewer Settings window.

Event Notification Settings areaMaximum frame rate for live viewing
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If a high maximum frame rate is specified, the load on the
computer CPU will be high and Viewer operations may take
longer. When AutoAdjust Frame Rate is ticked, frame rate is
automatically reduced when CPU load becomes high.

Note

Select a frame rate from the drop-down list.

Adjust frame rates automatically. Refer to “Administrator’s
Manual” for details.

Enable larger Video Window captions in the Viewer.

The current Master Storage Server is indicated here.

You can select the Master Storage Server when
launching the Viewer (→ P. 38).

Add the current Storage Server into connect menu.

Delete the current Storage Server from connect menu.

Set up notifications by priority
from 1 (highest) to 5 (lowest).
Priorit ies are color-coded as
follows.

Lower priority items can have less
notification settings associated
with them.

When ticked even if an event
occurs, it is not displayed in the
Live Events Log in the Viewing
Screen.

Color Priority

Red Highest

Orange High

Yellow Medium

Light Green Low

Dark Green Lowest

Set duration of alert.
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Viewer Settings window - Use large captions for Video
Windows

Tick Use large captions for Video Windows
to enable easier-to-read Video Window
captions in the Viewer.

Standard caption in Video Window.

Large caption in Video Window.

Viewer Settings window - Identify the Master Storage Server
A Master Storage Server maintains settings for Camera Servers and Layouts.

The selected Master Storage Server is
indicated in the Viewer Settings window.

Viewer Settings window - Configure the proxy server
When you wish to access the
Storage Server using the proxy
server set in the Internet Option,
tick Use internet proxy settings
and restart the Viewer.

Viewer Settings window - Configure layout in the Viewing
Screen

If you wish to confirm whether the
layout information has already been
saved when finishing the Viewer or
when switching to the Viewing
Screen, tick the Confirm if the layout
was preserved when quitting or
when the screen changes check
box and restart the Viewer. If not
ticked, the layout information will not
be saved.

Configure Viewer Settings
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Viewer Settings window - Configure Audio Transmission
Settings

The camera which is sending or
receiving audio to a Viewer cannot
interact with other Admin or NC
Viewers. You can automatically
terminate audio transmission after a
specified period of time even if you
forget to terminate it.

When using this option, tick the The voice transmission will be ended for a fixed time
automatically check box, and specify the period within the range from 1 to 60 minutes
(default is 10 minutes). When the specified period of time passes during audio
transmission, it will be terminated automatically.

Viewer Settings window - Configure Focus Settings
You can set the camera to return its
focus mode to the default setting
when the camera orientation is
changed. The focus mode returns to
default if it has been changed to
Manual after any focus operation
using a preset with focus setting
defined or via Cameral Control
Panel.

It returns to the default setting on the Camera side when the Camera is operated.

Automatic termination works even if the servers are
communicating with each other. Switching to another Video
Window resets the time. Tip
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Viewer Settings window - Edit Event Notifications
When an event occurs, it is indicated in the Live Events Log in the Viewer. In the  Viewer
Settings window, Event Notification Settings area, you can set up actions based on
events according to the priority of the event. To set the event notifications:

● Set priority alerts from Highest to Lowest

In the Priority area, you configure the following settings:

Tick the Operator Notification for box to enable a notification period when an event
occurs. Select a notification period in seconds from the Seconds drop-down menu or
enter it from the keyboard (0 - 99). When a event occurs, the event flashes in the Live
Event Log window for the period of time specified using this option, and a color bar
indicating the event’s priority light on the top of a live Video Window for one minute.

If you specify 0 second, an event which has occurred will not flash and a color bar
will light for one minute.

Tick the Requires operator acknowledgement box for the event. When an event
occurs it will flash in the Live Events Log and the audio alert will sound (if
specified) until the operator double-clicks on the event (That is, the notification time
will not apply to the event in the event log).

Tick the Audio Alert box to have an audio alert play during the event notification period. 

The Windows system sound “Exclamation” is used for audio alerts (For a PC with
no sound board installed, a beep sound is used). This sound repeats for the
duration of the Operator Notification. If Operator Notification is not set, the audio
alert is played once.

Tick the Don’t show events to have the event not displayed on the Timeline of the
Viewing screen or on the Live Events Log window even if the event occurs.

4

3

2

1

Configure Viewer Settings

Refer to the Viewer Manual for the information about the Live
Events Log window.

Note

Even if Don’t show event is ticked, events are shown in the
Search Results in the Event Search dialog.

Tip
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Saving Viewer Settings

When you have finished configuring Viewer settings...

● Click Save Changes to keep all your settings. The Viewer settings are then saved to
the local disk.

● Click Discard Changes to cancel any modifications you have made.

If you wish to return to the Viewer, select View > Viewing Screen from the menu bar.

The bottom right-hand
corner of the Viewer
Settings window
consists of two buttons,
Save Changes and
Discard Changes.
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Chapter 8
Arranging and Saving Layout

This chapter details how to create and save Video Window Layouts 
and Layout Sequences.
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Managing Video Layouts

About the Layout menu
The Layout menu allows you to save particular Video Window layouts for easy monitoring.

The name of the currently-displayed layout can be found in
the top-left corner of the Viewing Area, next to the Layout
button. You can create a new layout, save a layout or
open and rename a previously-saved layout.

Click the Layout button to open the Layout menu. You can also right-click anywhere in the
Viewing Area to display the Layout menu.

Below the Layout menu options, existing Layouts
are displayed and divided into two sections.

Shared Layouts:
All the users can available these layouts. You need
Administrator privilege to create a layout. Normal
users cannot modify these layouts.

Personal Layouts:
Lists layouts created by the current user. These are
shown under the Shared Layouts list to distinguish
the different types of layouts. Other users cannot
use them.

Optional
Layout
Menu

Shared
Layout

List

Personal
Layout

List

The layout displayed when launching the Viewer is the first
layout listed in the Personal Layouts (or in the Shared Layouts if
there is no Personal Layouts).Tip
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Managing Video Layouts

● To create a new layout (a previously-saved layout is displayed):

Click the Layout button to open the menu, and then select New Layout.

The Viewing Area will become blank and the default layout name “Untitled” will be
displayed.

The process of creating folders and saving a layout could be done in the following order:

1

Organize and create
Layout folders

2

Arranging Video
Windows in Layout

3

Save Layout to a 
folder

Drag the Camera Server’s thumbnails onto the Viewing Area to create the layout.



● Create a new folder...

In the Organize Layouts & Layout Sequences dialog, click on a shared or personal
folder and then click Create Folder.... The Folder Name dialog appears.

Enter a name up to 50 characters
and click OK.

The new folder will appear in the
Organize Layouts & Layout
Sequences dialog.

2

1
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Organizing Layouts and Layout Sequences
The Organize Layouts & Layout Sequences dialog allows you to create folders and sub-
folders in which to save item (layouts and layout sequences) (➝ P. 128). To display the
dialog:

● Open the Layout menu and select Organize...

The Organize Layouts & Layout Sequences dialog opens (Administrator version
shown). The Shared Layouts folder will not display if you have logged in as an Operator.

Create a new folder.

Move an item to 
another folder.

Move an item up or 
down within a folder.

Delete an item or folder 
containing items.

Edit an item name or
folder name.

Copy an item to 
another folder.

Managing Video Layouts
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Managing Video Layouts

● Move or Copy a layout or layout Sequence to another folder...

In the Organize Layouts & Layout Sequences dialog, click an item to highlight it,
then click Move to Folder....

The Select destination folder dialog opens showing a list of created folders.

Click to select the target folder in the list
and click OK.

The item will be moved into that folder.

If you selected Copy to Folder..., you
can copy items in the same manner.

2

1

● Move an entry up or down...

Click an item or folder to highlight it, then click Move Up or Move Down. The item will
move up or down within a folder.

● Edit or delete a layout or folder...

Click an item or folder to highlight it, then click Edit. The respective Layout Name or
Folder Name dialog will appear for you to overwrite a new name.

Click an item or folder to highlight it, then click Delete. If you have Operator status, you will
not be able to delete a shared layout or layout sequence.

� You cannot change the parent folder names, Shared Layouts
or Personal Layouts.

� You need Administrator privilege to manage shared folders 
(➝ P. 35).

Note
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● Step 2: Create a name for the layout or layout sequence

Change “Untitled” or an existing layout name to save the item with a new name.

Click a location in the list. Click to select the folder to save the layout and click OK.
The item is saved to that folder.

Alternatively, click New Folder to create a new folder (➝ P. 126) and save the item
in there. For example, if you wish to save an Administrator-shared layout to a
personal folder.

Once you have saved an item, the name will
appear next to the Layout button in the Viewing
Area.

2

1

Managing Video Layouts

Saving a Layout or Layout Sequence
Administrators and Operators can save layouts and layout sequences to an existing folder
or a new folder via the Save Layout dialog.

● Step 1: Open the Layout menu and select Save or Save As...

The Save Layout dialog opens. A New Folder button
and Name field is also available for you to create a
new name and location for the copied layout or layout
sequence.

Administrator’s 
Save Layout dialog

Operator’s 
Save Layout dialog
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Arranging Layout Sequences
You can set up an automated sequence of shared and personal layouts to display in the
Viewing Area at set intervals.

From the Layout menu, select New Layout Sequence.... The Add Layout
Sequence dialog displays.

Enter a sequence name for the new layout sequence and choose a Type: of layout
sequence from the menu, Personal Layout Sequence or Shared Layout
Sequence (you can switch between the two as you add layouts).

Use the Add Layout > button to add layouts to the new sequence. Click Up and
Down to change the display sequence of layouts. Click Delete to delete the layout.

In the Duration: menu, select a set duration of display time for each layout or enter
a custom time, overwriting the existing time.4

3

2

1

● Opening a previously-saved layout...

Click the Layout button to open the menu and then click a layout or layout sequence in the
list. The item will be loaded onto the Viewing Area.

If you select another item without saving the
current item, a dialog will appear prompting
you to save the current layout or layout
sequence (if the Layout setting (➝ P. 118) in
the Viewer Settings window is ticked).
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Managing Video Layouts

● Opening and running a layout sequence...

To start the layout sequence, select it from the Layout menu.

When a layout sequence is running, further options are
available in the Layout menu.

� Click Edit Layout Sequence to change settings in the
currently-running layout sequence. The current
sequence will be indicated as Paused.

� Click Resume Layout Sequence to play the current
layout sequence.

Click OK to bring up
the Select destination
folder dialog.

Select or enter the 
time. 
You can set the time 
within the range from 
1 to 9999.

Click Add Layout to 
add a selected layout 
from the left-hand 
column.

Click on a 
layout to 
select it.

Enter a new name.

Select a layout
sequence type.

Layout Sequence:

All the users can share these layouts. You need Administrator privilege to create a layout
sequence. Normal users cannot modify these layouts.

User Layout Sequence:

Lists layouts created by the current user. Other users cannot use them.

You can only save layouts as a layout sequence.
Note
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Working with Layout Grids

You can customize your layouts by applying one of the following grids:

� None - You can arrange Video Windows
freely.

� Alignment Grid - creates a grid of dots
in the Viewing Area. You can re-size
Video Windows using the grid.

� Small Grid, Medium Grid and Large Grid - creates a small (160x120), medium
(320x240) or large (640x480) grid where you can place Video Windows in a tile-like
manner.

� Custom Grid - You can set the grid size.
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Working with Layout Grids

● Drag, drop and re-size a Video Window

In the Camera Selection Area, click a
thumbnail image and drag its selection
boundary onto the Viewing Area grid. The
boundary will re-size.

Release the mouse button. The selection
will become a Video Window, and “snap”
into alignment along the grid closest to it.

To re-size the Video Window, click any
corner and drag the image outwards to
snap to a larger grid area. Release the
mouse button. The selection boundary
will become a Video Window and “snap”
into alignment along the grid closest to it.

2

1

Working with the Alignment Grid
Select the Alignment Grid from the Layout Grids sub-menu. The Viewing Area displays a
grid of dots. When you place a Video Window, it “snaps” to the grid boundaries.

● Create and align more Video Windows

Click and drag other
camera thumbnails onto
the Viewing Area to
create Video Windows
for monitoring, and resize
the window. A layout
example is shown to the
right.
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Working with Layout Grids

● Working with Small, Medium and Large Grids

When you select Small Grid, Medium Grid or Large Grid from the Layout Grids sub-
menu, the Viewing Area displays “cells” for Video Windows. These are boundaries
indicating a uniform size which is used to display Video Windows in a tile-like manner.

● Drag a camera thumbnail image into a blank tile

In the Camera Selection Area,
click a thumbnail image and drag
its selection boundary onto the
Viewing Area grid. The boundary
will re-size.

Release the mouse button. The
selection boundary will become a
Video Window and “snap” into
alignment along the grid closest
to it.

To re-size the Video Window, click any
corner and drag the image outwards to
‘snap’ to a larger grid area. Release the
mouse button. The selection boundary
will become a Video Window and “snap”
into alignment along the grid closest to
it.

2

1

� The Layout menu is also available by right-clicking anywhere
in the Viewing Area.

� A Video Window can be increased in size to take up a number
of tiles, (for example 4 tiles, 9 tiles etc) so that Video Windows
of different sizes/priorities can be viewed.

Tip
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Working with Layout Grids

The Viewing Area with a Small Grid could look like this:

The Viewing Area with a Medium Grid could look like this:

Although you can add more, the number of Video Windows you
can display simultaneously will depend on your video card, the
speed of your computer, the maximum frame rate (➝P. 117)
configured with Viewer setting, the video size and video quality
coming from the Camera Server and the size of each Video
Window displayed. A maximum of 16 cameras is recommended
in the Layout Area.

Note
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Working with Layout Grids

The Viewing Area with a Large Grid could look like this:

In this example, the Camera Selection Area and Timeline are hidden.
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Working with Layout Grids

Working with the Custom Grid
The Custom Grid feature allows you to set a custom-size for displaying Video Windows.

● Set a custom grid

Select Custom Grid from the Layout Grids sub-menu. The Custom Grid dialog
appears. Values are given in pixels.

In the Horizontal or Vertical field, overwrite the
existing value with a custom value, or use the
up/down arrows to select a value. When you
adjust the value in one field, you’ll notice the
value change in the other field. This is because
the proportions of the re-sized Video Window
are constrained and the dimensions are scaled
accordingly.

Click OK to close the dialog. The grid will re-size to your new settings.
3

2

1

Using Custom Grid may cause high CPU load.
Note
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Hiding and Showing Task Areas

The View menu allows you to show/hide task areas and other display elements in the
Viewer. When you unselect Camera Selector and Timeline and then select Fullscreen,
the result is a large area in the Viewer for displaying more Video Windows as shown
below in the Large Grid example. Pressing the Esc key returns the menu bar. You can
also select to hide Video Window Captions, the Camera Control and Live Events.

The number of Video Windows in the display achieved is dependent on the display
resolution. A higher resolution will result in more Video Windows displayed.

View ➝ Camera Selector

View ➝ Timeline

View ➝ Full-Screen (Large grid, 1280x1024). The Windows task bar is also hidden.
Pressing the ESC key displays the task bar.
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